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OVISION

GOVERNMENT SOLUTIONS

How to Make a Vacant Parcel Improved

The purpose of this document is to assist the user in changing a vacant land parcel to an improved parcel with
building information.

1. Select the vacant parcel that will be changed to Improved.

2. Select Classification & Land Information from the Classification & Land Information sub
menu, located in the tree on the left hand side of the screen.
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The Classification & Land screen will open.
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3. Click on the vacant land line and then click Edit Lines.

204



Building Classification And Land Line Valeation

" Urat Ace Lamys
.aug*t Line 2 Lm ‘mw Unas Te Appraiied _uumd ¢ lme :W ‘mavlmem
| > - A WOW  SID-ivDanVacast - - S AC - $1E7S0000  §EFMO00 Vo "
g Acred 5 Aggrained §167.500.00 | Emtlnes
i ike
WY SD - Urban Vecant 100 R

| The Land Details screen will open.
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4. Change the Use Code to an improved code.

~  Thecode can be changed in two ways.

e Type the Improved Use code into the Use Code field.

e Use the drop down menu either by clicking on the drop down arrow on the Use
Code field or click on the field and hit the F6 key.
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5. When you have finished, click Close.
Totals ;’
Appraised 167500 r
/
I Next ! | Add ] Delete ;:
{ Close Land Details [ j

6. Click on Construction Details from the Building Information sub menu, located in the
tree on the left hand side of the screen.
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Photos f
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7. Change the Model and Style from Vacant to the model and style of building on the
parcel and select a Grade. Fill out all other fields with applicable data. Required fields
are marked with a red outline and exclamation mark. Required fields are set in the
Admin Module.
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{@ The Model and Style can be entered in two ways.

¢ Type the New code into the Model and Style field.

e Use the drop down menu either by clicking on the drop down arrow on Model or
Style field or click on the field and hit the F6 key.

8. Next, Depreciation needs to be entered for the added building. Select Depreciation

from the Building Information submenu.
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The Depreciation screen will open.
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9. Enter the Year Built and the Depreciation Code.
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You can enter the Depreciation Code in two ways:

e Type the code or value in the Depreciation Code field.

e Use the pick list to select from existing codes in the database. This can
be accessed either by clicking the drop down arrow on the Depreciation
Code field or by clicking the field and hit the F6 key.

If the parcel is under construction, enter the Status and Percent Complete.

Comment
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10. A Sketch needs to be added to the parcel if it has a building to provide gross, living, and
effective area values. Select Sketch from the Building Information sub menu, located in
the tree on the left hand side of the screen.
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11. Enter your Sketch. See Using the Sketching Tool for instructions on how to add sketches
to a parcel.
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12. Once the Sketch is complete, click on the save changes icon
save your changes.

or press the F2 key to
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You are here: Parcel Maintenance > Basic Process > How to Use Real Estate Audit

OVISION

GOVERNMENT SOLUTIONS

How to Use Real Estate Audit

The purpose of this document is to assist the user in reviewing the recorded changes to a Real Estate parcel. Data can be viewed and sorted on
the Parcel Audit screen and also printed for review.

Note: To set the default view to Basic Audit, navigate to ADMIN > Table Maintenance > Par Tables > G | and check the box indicating
Basic Auditing Defaulted. For configuration instructions, please reference the Basic Audit Canfiguration topic found in Admin Help.

1. Select the parcel for which you would like to review the Audit Trail.

2. Select Parcel Audit from the Legal Information sub menu, located in the tree on the left hand side of the screen.

Legal Information

Account Information

Owner And Deed

Exemptions

Abatements

Parcel Addresses
Associated Parcel
Motice History
Property Nol
Parcel Audit

e

This opens the Parcel Audit Screen

Parcal Audit
[¥) Basic Auditing !

5 :é_\m-m iDat.eﬂ!mE Toble
W oAa . = - Ay -

| 04/21/2019 ahdate
042172019 ahdate
04/21/2018 ahdate
04/21/2019 parcel
0472172019 paicel
04/21/2019 parcel

AHD_MRKT_ASSESS_VAL
AHD_TTL_ASSESS_ALT
AHD_TTL_ASSESS

PRC_TTL_COST

PRC_TTL_ASSESS
PRC_TTL_ASSESS_JMPROVEMENTS

To sort by a particular field, click on the column header.

Parcel Audit

Basic Auditing
] H ]
[UsedD | Date/Time |Table

T As = - Aa -
04/19/2019 ahdate
04/21/2019 shdate
04/19/2019 ahdate
04/19/2019 ahdate

Assassmaent History
Other Assessments

Supplemental Data

Assessment Change

_Sub Division Hisgq/

»

A

e L T

e N

. —

| Desenption

As
Modified: Market Assess Value Old Value: 334400 New Value: 337500
Modified: Tt Assess Alt Old Value: 334400 New Value: 337500

Modified: Tatal Assessed Parcel Vaiue Old Value: 416700 New Value: 419800
Modified: Cost Old Value: 416700 New Value: 419800

Modified: Total Assessed Parcei Value Oid Value: 416700 New Vaiue: 419800.00

Modified: Total Assessed Improvements Old Value: 334400 New Value: 337500

Freld ‘& | Description
&a A2
AHD_ASSESSM Modified: Ratio Old Value: NOT SET New Value: 100

AHD_MRKT_ASSESS_VAL
AHD_MRKT_ASSESS_VAL

Modified: Market Assess Value Ofd Value: 338400 New Value: 337500

Modrfied: Market Assess Value Cid Value: NOT SET  New Value: 334400

AHD_PROP_TTL_APPRAIS_LND_DEF Modified: Prop Total Appraised Land Def Otd Value: NOT SET  New Value: 0

You can aiso filter data by typing in a column’s filter field field.

In the below example, the Date/Time column is filtered to return changes recorded on 4/19/2019.
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| Parcel Audit

1 1 T . . =
Voa - = s - .
04/19/2018 ahdate  AHD_ASSESSMENT_RATIO
| 04/19/2019 shdate  AHD_MRKT_ASSESS VAL
[ 04/19/2019 ahdate  AHD_PROP_TTL APPRAIS LND_DEF
[ 04/19/2019 shdate  AHD_SAVE_DATE

To remove a filter, click the delete filter icon Y or manually remove the text with the backspace key.

Parcel Audit
| @] Basic Auditing :
| |Usedd Dmeflime  Toble [FeW .+
IRz N I :
| 04719/2019 AHD_ASSESSMENT RATIO
! 04/19/2019 AHD_MRKT_ASSESS VAL
| 04/19/2019 ahdate  AHD_PROP_TTL_APPRAIS_LND_DEF
! 04/19/2019 ahdate  AHD_SAVE_DATE

To read the full description text, double-click the target field. A window will appear displaying the full audit text.

Parced Audit
(¥ Basie Auditing
sed Do/ [Toble  [feld = |pescrption
LA = 4/19/2019 - W, A - Aa . 4a
04/19/2019 shdate AHD_ASSESSMENT_RATIO Modified: Ratio Old Value: NOTSET MNew Value: 100
04/19/2019 ahdate AHD_MRKT_ASSESS_VAL Modified: Market Ay Qid Vaiue: NOT SET New Value: 334400
04/19/2019 ahdate AHD_PROP_TTL_APPRAIS_(ND_DEF Modified: Prop To P Land Def Old Value: NOT SET New Value:
P 04192019 - ahdate - AHDSAVELDATE - Moskfieck Dato Saved A/LT/2009 120000 AM New Value: 471972
04/19/2019 ahdate AHD_TTL_APFRAIS_BLDG Modified: Total Building Old Value: 332200 New Value: 329100

Modified: Date Saved Qld Value: 4/17/2019 12:00:00 AM New Value: 4/13/2019
12:00:00 AM

3. To print the audit report, click the Preview button.

Parcel Audit

B7) Basic Auditing

_ Uiedd  [Osteffume  [Toble Fwd

Y, As - = 4/19/2019 < Y A - A2 =
04/19/2019 ahdate  AHD_ASSESSMENT_RATIO
04/16/2019 ahdate  AHD_MRKT_ASSESS_VAL
04/18/2019 ahdate  AHD_PROP_TTL_APPRAIS_LND_DEF

r N -m  ahdate aMMﬁ~Hm
0471672019 ahdate  AHD_TTL_APPRAIS BLDG
04/19/2019 ahdate  AHD_TTL_APPRAIS_LND_DEF
04/19/2019 ahdate  AHD_TTL_ASSESS
04/15/2019 shdate  AHD_TTL_ASSESS_ALT

4. The Parcel Audit Report will dispfay in the Print Preview screen.
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O Plint Previes

i1
J00 OEBE P
USER AUDIT REPORT ‘
On 4/24/2019 3:43:53 AM .
|
UseriD: i
Date/Time: 4/19/2019 4:45:12 PM
Table: ahdate
Field: AHD_ASSESSMENT_RATIO

Description; Modified: Ratio Old Value: NOT SET  New Value: 100

UserD:

Date/Time: 4/19/2019 4:45:12 PM

Table: ahdate

Fiekd: AHD_MRKT_ASSESS_VAL

Description: Modified: Market Assess Value Old Value NOT SET New Value: 334400

5. Click the print icon on the top toolbar.
O Brint Preview

JD e BEE

ER AUDIT REPORT
On 4/24/2019 $:43:33 AM

UserlD:
Date/Time: 4/19/2019 4:45:12 PM
Table: shdate

6. The Print screen will appear. Select the desired printer and click Print.

General ]

Select Printer

~

a Fax @ Send To OneNate 20 |

ami Microsoft XPS Document Writer o Snagit 10

C Duitrant Padgis

—

© 2019 Vision Government Solutions Inc. All Rights Reserved.
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You are here: Owner Maintenance > How to Search for an Owner

OVISION

GOVERNMENT SOLUTIONS

How to Search for an Owner

The purpose of this document is to assist the user in utilizing the search function of the Owner
Maintenance screen to retrieve existing ownership entries.

1. Select Owner Maintenance from the left navigation tree.

1L Parcel 1
& y
< d
/g, /
-u.y. Reports Ky )
7
Table Maintenance 2
f
Comps & Apportionment i
Cost Modeling 1
I

o e Ry Y g SR A

The Owner Maintenance screen will appear.
% : [ d :M — - - .“ » [ 3

214



1. To search for an existing Owner click in the Search box at the top of the screen
and enter all or part of the owner entry you wish to retrieve.

s | [Search] !

e

| Type Owner Full Name
!
W Ae N Aa o Aa i
1
3
?

ﬂwnﬁ,/,,/d}‘r-""_h“u!ayl b o f i e 7- 7 = e ,,&‘.A’J

2. When you have finished typing, click the Search button.

SMTH ',

Type Owner F ‘ ar '

W A - Aa v Aa

Pt s f.-»i-e.r..-f—“..l"__!-ud b s ,__“_‘«fua—r)"/ e T /

Results will appear in the grid below.
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The order in which results are displayed can be changed by clicking on one of
the column headers of the search results grid.
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Type - Owmner Full Name Co-Owner Full Name ?

A @ 2 v A - M
000000 RE SARAH SMITH JACOB JOHNSON f
000000140 RE SARAH SMITH JACOB JOHNSON ’
000000144 RE SARAH SMITH JACOB JOHNSON
000000148 RE SARAH SMITH JACOB JOHNSON /
000000152 RE SARAH SM¥TH JACOB JOHNSON ;
000000156 RE SARAH SMITH IACOB JOHNSON ’I
000000160 RE SARAH SMITH SACOB JOHNSON 3
000000164 RE SARAH SMITH JACOB JOHNSON e
000000168 RE SARAH SMITH JACOB JOHNSON ’
000000172 RE SARAH SMITH JACOB JOHNSON i

F

Results can also be filtered by clicking on the filter B row below the column
header concerned. In the below example results for ‘SMITH’ are being filtered
for results with an owner full name that starts with ‘G’. To remove filters click

the remove filter % button.

[smiTH | | search |
Type Owner Full Name Co-Owner Full Name
LA ’ A . G A ) .
000123456 RE m@
CAAL I T BT D RO ’,
TARAN TN T AT T HRROMN ,,
LARAH A T M T 0N ,
y_,“”u__f.,,/‘ SR L R ., po— ,,‘/""w_ EE e PR AR T 2wt P AP d

3. To view more information that what appears in the search results grid, select the
result concerned by clicking on the line and the detailed information will appear
below under Account, Owner Information, and Co-Owner Information.

216



[iasrin ) Gt}

Vg ey 1wl M it |l Seare Ay Low | Ly S

L » » [ » v » E
SO0 L 3 LAR s AETH LA O OISO ¥ Mgim S I e Y
O 008 e LA LT TALDE [HNRON & o Anyroer L)
[ " LAt LTy WO KON Yndon 9 Ayt an [

[ “u—i«-—*m‘n-&m Ly g ' AORIGEON T AMamw v—\nm-"(*—-"'
ETYEaY o ey WA ey WO MY § g & Aty [
o, ! - L4 LA T AL MO IRON & o 51 e s
AR08 L3 Lhtasg LARITH WAL SHAON & Mimn B Arpremr L]
QONO0O0 S RE SARAM VAT LAL T CMNSON 7 Nga 2 Amypun A
00U - " LA a0 WAL O XM 7 s B ) L]
SO B R PRV T WA Of NSO 4 ximn 9 ATt L]
SOOOTEO " LARA SARTH MACOB WO Shagn Amymus a

422 Camer Lo A ppmey Do Ascrited Ducy ekt A
R
P Tiee Sagurens  Mlereae
momce BE Bew Extame .

Cwi 1 N LGt e T O foll N
LA b Al e A e
abtgma  Tert Pame A 1ot Newe e Sehtilhon  Fest Nae thuite 09t

- AL At w! lacon KIEHON
Lwad e i P et o
oy Dot L Uprms oo Atermre Ty b e e Moy (0w

.lw«u;uu Gﬁ' - - - fm':mﬂl - -
. amm—— et
‘. ».
' 7. A new search can be started at any time by repeating steps two and three.

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Owner Maintenance > How to Add an Owner

OVISION

GOVERNMENT SOLUTIONS

Adding an Owner

The purpose of this document is to assist the user in entering a new ownership entry into the Ownership
Maintenance screen.

1. Select Owner Maintenance from the left navigation tree.

Comps & Apportionment
Cost Modeling

«

L A L aaanathe = -
- — e 2t —— gy

b o

The Owner Maintenance screen will appear.

- wem s

Before a new owner can be added, you must first perform a search to ensure
the new owner intended for entry does not already exist in the database.

2. Click in the Search field and type in the name of the new owner. Click Search to see the results.
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File Cards Utilities Help

G g § Sy

EE =

Vision 8 Application Explorer v I X WdYNd
Owner Maintenance #® |

| Account
Owner Maintenance T As

3. If the new owner intended for entry does not appear in the results, click the Add Owner button

to make a new entry.

Type
Aa

Owner Full Name
. Aa

[Pl Cormn Utities beip

Ee) "N

- A - [rans
Dwires Mo " A
Owner Malntensnce £ —=
Dwres Marsemgrce %

A blank ownership line will appear in the grid and the black information fields

will appear below.
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4. Begin by filling out the Account information section. Enter the relevant information into the
Account, Type, Suppress, and Alternate Id.
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Account Information $

Account Type Suppress  Alternate Id
000123456 |RE: Real Estate vl [ |

5. Next, fill out the Owner Information fields. Required fields will be marked with a red outline
and exclamation mark. These are set in the Admin Module.

Owner Information

Owner Full Name || Edit Full Name
THOMAS PAUL NELSON

Salutation  First Name Middle Last Name Suffix

Mr: Mi ™ | THOMAS PAUL NELSON

Email Phone Home Phone

tpnelson@vgiicom 555-555-0005 555-555-0004

Type Dob Ssn Edit Marital Code Reference

[-’rf-:.-'l-;o',? Ea: wos - we - weme 4 Single ¥ || Veteran

Comment

If this owner entry has a Co-Owner, fill out the Co-Owner Information section
with the relevant information.

Please note, if the owner owns multiple properties in the database and some
are without a co-owner or with a different co-owner, a separate owner
maintenance entry would need to be created for each unique combination.

Co-Owner Information
Co-Owner Full Name || Edit Full Name
Salutation  First Name Middie Last Name Suffix
M- M »
Email Phone
Type Dob Ssn Edit Marital Code Reference
-‘Sz-i—eu & rjatc.g! - - v [ ] Veteran
Comment

6. When you have finished entering the information for the new owner, click on the save changes

)

icon .
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File Cards Utilities

3 0@"97&1

Vision B Application Explorer

Parcel « h

The new owner entry will now be available in the Owner Maintenance screen
and available for addition to new sale records in parcel data. For information
on entering a new sale to the Owner and Deed screen, please see the How to
Add a New Sale Record document.

NELSON - [searen]

Type Owner Full Name
Y & - &= . (] -
b (000123456 RE - THOMAS PAUL NELSON
MR T AR G T PR el /', A pein e -“«wm»r.....,.hw,_.;l"“" St

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 {800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Owner Maintenance > How to Update an Owner Mailing Address

OVISION

GOVERNMENT SOLUTIONS

Updating an Owner Mailing Address

The purpose of this document is to assist the user in updating an existing owner in the Owner Maintenance module.

1. Select Owner Maintenance from the left navigation tree.

(L Parcet 1

~ Owner Maintenance |

gy |

[ revte Maintenance ;
4
Comps & Apportionment
Cost Modeling 4
ey T e P v e e
€D  The Owner Maintenance screen will appear.
Vish podicabon Explarer - 0 x| |
Dumer Mok - Account 1 Owner Full Nan Co-Owner Full
|€o- me
= 2 toun Ype e Ful e o F Iy
Owner Mantenance L : A Y- . &

2. Search for the owner entry that needs to have the mailing address updated. Type part of the name in the search field and
then click search.

[NELSON | [Search ]
1 Owner i |
L & M 2 - §
» 000123456 RE © THOMAS PAUL NELSON. - vl
i

R T O D e P Lo I Y oD b PV e o.J;
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0 For more information on using the owner search, please see the Searching for
an Owner document.

3, Click on the owner entry you wish to update from the results. Once the owner has been selected, click Update Address.

[ ) Gas) A

e Oy Full Namse o0
% & B & = ] - e
Y GORMES - RE- . THOMASPAULMESON

2

0 The Mailing Address Maintenance screen will appear.

THCRLAS FALR, NELSON
S Linw § 4l

Caw (A

Aareny Fhcengnoe

ey L | Ovenrite ket Duvady
X A I

g v §

hatven L )

4. To begin making changes click on the address for the selected owner that is to be updated.

Ll L T
LR -

S0 OHOMASRANGSON e U

e e BT RETATIITES

5. Make any necessary edits to the Address Type fields,
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| 1: Primary - w(/ - v/ gl el
Name Line 1 |
[THOMaAS PAUL NELSON y
Name Line 2

[

Care O

| Dackson accion : J

T s

6. Make any necessary edits to the Address Information fields.

Address Information .

Andress Line 1 L !mmm 4

12 MAIN ST 11 '.

Address Line 2 {

1

Address Line 3 "

' 't

!

Box Number  Pre Direc Post Direc. r

b Ll ll

Street Number Prefix Street Name :,

12 | MAIN 1

Street Type  Suffix Unit Nurmber Unit Type i

tswea el e 0 B Nl

Changes will be updated In the grid.
Mg Acsannss MaifTonaece
PAUL NELSOM
Addrens Type e L 1 L aidresa Lee t City  State Fo Carvier
hoseoc o - . S I - - -

L © o THOMAS PALL NELSOR 12 MAIN ST LY - Y Lo - | L

Ausa Aaceens Deete Aodven.
ddp = B e -

7. Once all address changes have been made, click Close at the bottom right of the Mailing Address Maintenance screen.

8. Click on the save changes icon n to save your changes before navigating out of owner maintenance or searching for a
new owner,
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You are here: Owner Maintenance > Supplemental Owner Data

OVISION

GOVERNMENT SOLUTIONS

Supplemental Owner Data

The purpose of this document is to assist the user in adding Supplemental Owner Data in the Owner Maintenance screen. The fields on this
screen are defined by the user, for information regarding setting up supplemental owner data please see the Admin App documentation.

1. Select Owner Malntenance from the left navigation tree.

| OwnerMaintenance |

oL\

~ceT

A
[ rate Maintenance f
—— /
Comps & Apportionment 1
Cost Modeling 4
1
-
- o T P e = |
The Owner Maintenance screen will appear.
isien 8 Application Explorey v 1) i ! |
Owner Maintenance B | I e T Owner Full N Co-Owner Full Nam
LAccoun | [ame O
Owner Maintenance 'y t - yPe b L3 il <
Owner Malntenance W A : 24 : 4 : L

2. Type the owner name you wish you add Supplemental Owner Data to and click search. Select the owner desired from the

list of results.
sy [ —)

Typl - Owner Full Name
N e / A . IS

D i T T b L P PURNIP ol LA et

€9 For moreinformation on searching for owners, please see the How to Search for an Owner
document.
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3. Once the owner has been selected, click the Supplemental Data button.

feson - [Sew]

Type ’  Over Full Name te
4 © " -l
b OOIZMID ol THOMAS PAUL NELSON =g = ovires

. '+ The Supplemental Owner Data window will appear.

Oty Riytin

THOMAD FIGA. LAY

e — e T 1
et e ol - i
O s it 1 [

4. The available Supplemental Owner Data fields will be displayed. Enter the relevant data into the appropriate fields. If a
supplemental data field has a list of pre-defined values you may select them from the drop down pick list.

PI1: Pick ltem 1
P12: Pick item 2
PI3: Pick item 3

Pick list assignments, pick items, required fields, and numeric character
restrictions are all controlled by settings in the Admin Application. Please see
the Admin App — Table Maintenance documentation for more information
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5. Once all relevant data has been entered, save the information by clicking the Save button at the bottom right of the
Supplemental Owner Data screen.

| Save || Close |

™

6. Click on the save changes icon
new owner.

to save your changes before navigating out of owner maintenance or searching for a

File Cards Utilities Help
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You are here: Owner Maintenance > Owner Associated Documents

OVISION

GOVERNMENT SOLUTIONS

Owner Associated Documents

The purpose of this document Is to assist the user in adding associated documents to an owner record in the Owner Maintenance module.

1. Select Owner Maintenance from the left navigation tree.

(L) parcel
| OwnerMaintenance |

e (X4

)

Emmm ,
Comps & Apportionment f
‘Cost Modeling 1

= e e I e S | wdadl

€3 The Owner Maintenance screen will appear.

Vigion 8 Application Explores v | I | |
_ = = Account T Owner Full Name Co-Qwner Full Name
coun o ul
Owner Maintenance ® Lo ;
Owmer Maintenance H M ; A - . M

2. Type the owner name you wish you add an Associated Document to and click search. Select the owner desired from the

list of results.
INELSO . :
Type \ | Owmer Full Name
W & LS . As
» 000123456 RE THOMAS PAUL NELSON
B ST PTe P T PY S PO D o =T

For more information on searching for owners, please see the How to Search for an Owner
document.
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3. Once the owner has been selected, click the Associated Docs button.

4. To enter a new document, click the Add button

(v [Lisa! aetrte

The open Associated Documents window will appear.

Ny Desktop B Deiidop A Documanis
i\ Dotuments 4]

R Downlonds #
[ i h Daantosds b Musie
|

£ Picvures

B Yideoi
J VISION IMAGES & Prctures Vidans

& LoearOinkicy 14
4 d

% danel_pemardini Devicas and drives (21

o images Nvtien i

2 AV4 CAVISION M. Y

e or BGE

File pame: |

(O] o1 M ThisC v o L »

Organze ~ e (4 @
# Toldey (6}

W Thes PC

w61 y sl Dva (C)
7 (NSTALL DOCS N\ - T .3 DVD RW Drive (O

':-‘y-}-ﬂeﬁ“‘,v—'_,- L >

5. Navigate to the location of the document to be added to the ownership record. Select the desired document and click the

Open button.
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(€ + -t k- DOCUMENTS » EXAMPLE

Ogaze ~ New bider ] )
Marew s st T Y
~.n;i:w @' {xarvpse Document.socs DO EEA A M et O, wal
§ Documents @

B Downioady A @
b Musc B
& Qures
8 Videor :1'_J

£ VISION-IMAGES

& Loeal Dmw s

7 daes_bernardn)

# WETALL_DOCS

3 Mages Awison;

» AVA WISION MY § zE=. =rye e s - ;| >

Fde pame £xample Boiment.oocs - # -l

/> The open File Storage Location Type window will appear. Select a location to store the file.
If you choose database this file will be added to the Vision Database. If you choose File
Share the document will be saved to the Vision Documents Shared Network folder .

@ Database () File Share

Note: If the File Storage Location Type does not prompt, this means the File Share Location
is not configured. Please contact Customer Support at 1-800-628-1013 for assistance.

The newly added file will appear in the grid.

Dwstrnipuen Premsty Sun Dgle Fle Kame
P IO s e D ey - e e
g e ey
1 1s Prumary

6. Associated documents can be given a description. Click on the document desired in the Associated Documents window
and type a document description in the field below. The grid will be updated with the description added.

7. Documents can be flagged as Primary to indicate the most important document for the owner entry. Select the document
to be flagged as primary and click the Is Primary box

b e Oloume Do . o I I —r -
et o - ;

o] o) vt

Evamphe Dovument Descrption iz My

L Sae | Com ]
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8. To open a Read Only copy of an associated document, select the desired document from the grid and click the View

button

Enampie Decumend Dscrgtas

€ The document will open as Read Only in the defauit program for the document type. In this
example a .docx file was used which opens in Microsoft Word by default.

Example Document

Thiy & o8 emasply @onungar

9. To make changes to an existing associated document, select the document concerned and click the Edit button.

SISt useple Caeatde o

o ey

The document will open in the default program for the document type. In this example a
.docx file was used which opens in Microsoft Word by default.

L o Eamps Paun S - ot "M - A x
NSEAT  Ofwil WOELAWVOUT  BDAECES  MANANGY  WIVEW VW et b et
B % cumnoln - n 8w b e 5T i e e B
e BV wnw 87 A-BFo& - O trs Vi len gt . wng
Example Document

Thin 11 0% 09 a1l

10. Make your changes to the document. After making changes, be sure to Save. In the below example the document was
opened in Microsoft Word, the save button Is on the top left.

a LA ] Dubrpiy DOTUmIRL 44400 Wesd
W OWSERT  DESGH  PAGRIAWMI  REFRENGES  MAMWKGS  BSVIEW VW

R I S SEI 3 ek T akeion assucens AaRLCH

2: R iU e, W R-T-A- W FEE e e Waamd  THOSpM  Hewding t
[t ol - Duragh Tyt
Example Document )
| Thia fa wn exnsnple document.
|
Wmdw-mmwca

11. To remove an associated document from an owner entry, select the document to be deleted and click the Delete button.

" The Document Deletion notification will appear. Click Yes to remove the document from
the ownership record.
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Are you sure you want to delete this document?

12. Once all changes to the Associated Documents for this ownership record have been completed, click the Save button.

Oeopoen

» b

(Ko o i tere

| [narnpie Document Desengtan
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You are here: Owner Malntenance > Related Accounts

OVISION

GOVERNMENT SOLUTIONS

Related Accounts

The purpose of this document is to assist the user in utilizing the Related Accounts section of the owner malntenance module. This section

allows the user to review Real Estate Parcels and Personal Property Accounts to which the owner entity is connected.

1. Select Owner Maintenance from the left navigation tree.

. e R o S i
The Owner Maintenance screen will appear.
Vimon B Application Explorer w B x| | D
COwner Maintenance b
Azcoum T Cwner Full Name Co-Owner Full Name
Owner Maintenance & Liad > =
Owner Maintenance W As . Aa . J.']

Aa

2. Type the owner name you wish you add Supplemental Owner Data to and click search. Select the owner desired from the

list of results.

[NELSOD

| [Searendl——1] @ )

Type | Owner Full Name
N & A . ™
» 000123456 RE © o0 THOMAS PAUIL NELSON

B e IR PRI ol AR [ S



€» For more information on searching for owners, please see the How to Search for an Owner
document.

3. Once the owner has been selected, click the Related Accounts button.

(oem | Gesat]

Type Cwmer Full Narme Co-Ow
L ' » ) » . L
b 00 ZRA5E L3 THOMAS PALL NELSON

L

€ TheRelated Accounts screen will appear.

Aaacdita AlLooet
et A3 | Ot Saams | oo Acxmnart Nty Tow i) Asrett Type Actoaat tata
3¢ Cumsm Ouree 21 MAIN ST 19 000 00 YW RlERmte A
Fyrvevidl Fropemy Aoourty
Acrrasnt b Vasrl e | O Mats |onmtion Acconnd hustes Los i0) Aot [gpe Aot Meme

=

The Related Accounts screen displays a list of all Real Estate Accounts and Personal
Praperty Accounts on which the selected owner entity is recorded including the following
fields:

Account ID- The internal parcel or property account identification number
(PID, PropID).

Year Filed(Personal Property Account only)

Owner Status- Current Owner, Past Owner, Future Owner

« Location- Primary Parcel/Property Account address

Account Number- Parcel/Proprty Account number
Tax ID- Map/Block/Lot/Unit
Account Type- Real Estate, Personal Property, Central Assessed

Account Status- Parcel/Property Account status (Active, Inactive, Future)

4, Users may open any related account from this screen. First select the account to be opened and press the Goto Account
button.
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Acroaee b Yearf | Sttt [eution | & 1 :.luﬂ_ww_kmun

@
Lo i[_Gow 1

(_’ The selected real estate parcel or personal property account will open on the Account
Information screen.

[ o w W wes 11 ey Pt s, e ) x
Aot Mmper 0077 1 L mes 1| Dot (gt Comete Do 3110200

e (L1 -

Prrgmy Locemar: 51 waady i1 - i e

Corimen e st £ ooty LiE 00 5 Lot v
e I m [ Boorrisn .

Oy Mpae | Rk Faeh A

nteny e [
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You are here: Table Maintenance > How to Add an Assessing Neighborhood

) VISION

NMEN

How to Add an Assessing
Neighborhood

This document will guide the user through table updates necessary to create new Assessing
Neighborhood codes.

Section I: Cost Modeling

1. Click on Cost Modeling in the Application Explorer tree, then select Assessing
Neighborhood Base Rates. Due to flexible labeling, your table may be labeled as
Neighborhood/Market Area Land Valuation or another similar label.

Cost Modeling

Cost Modeling 2
Cost Valustion Codes
Assess Neighborhood Base Rates

2. Select the desired Building Type for the new neighborhood code.
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Assessing Neighborhoods

Building Type
Code Description

03 Vacan

» 01  Reslential
02  Mobde H
04 Condo Ma
05 ResCondo
06 Com Condo
94 Commercial
85  Serv Station

96  Industnal

3. The new Code is added via either manual entry or the copy function.

a. For manual entry, enter desired data in the top row indicated by the plus

(+) sign.
Amvusty Rutphastast 1 e pcicads OO W TIOIED ' ~Namam ok g ol
T Al sy S et sy - - - - e ———— -
[ LR —— A e - I
Btng *y0 .‘- - ——— SN - —— ——— .u'- = e
| ) o - g L . [N
i S ey Tire aa - * 1e
v l Pe m Lo s - m - M - VD LAD0. IO -0
Kt 1060
KL L%
i K 5000
"
| #l 0
| ) 10

b. To copy, select the source code in the From: dropdown, then assign a new
code in the To: box. Select the desired target Building Type, then click
Copy. Review the Confirm Copy pop-up then click Yes to approve.

- Copy hsaring Sergrbormood
| bom: | G0 = Arccentad T TEETZ | Ul: Reaerns
Freeae e M Saie Trmad
“_mv". weme Cotl Model ﬂ
™ . . .
L8] ! Raridrtal 1900 MS - R
LIBA eiheral 10 KES v RL
A ¢ L) Rgiherta 0 RES -~ B

TN ey of ids antmrd i 1WA TR Ly

Dupttum sh e gow sad]

c. Review the new codes, altering as necessary. Once complete, click Apply.
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4. If you use or plan to use Comparable Sales, you should repeat these steps for
that table.

| Vimon § Appecstion bapdenr  w B < |
| Camps & Appertionenent -
Comps & Appostiomment %
Saip Trending facisrs
Cerprrme Yo Ureny

ASUEME Natigm DS Rates
Run trenging & k

Section 2: Land Tables

1. Click on Table Maintenance on the tree on the left side of the screen and select
Land Tables. Click on Assessing Neighborhood Base Rates. Due to flexible
labeling, your table may be labeled as Neighborhood/Market Area Land
Valuation or another similar label.

Vision § Appheation Explarer - R o
Table Maintenance 5

Building Tables £ -
Cost Use Cooes

Cost Group Rates

Buiicing Sodel Types

Styte Codas

Sizm Adjustment Table

Subareas

OBXF Codes

OBXF Adustments

EYE Deprecation

Deprecation Tabies

Amortizea Bamptions
Land Tables ]
Land Class

Land Types

Regions

Assess Neighoornood Base Rates

Stze Adustment Tabie

2. Select the desired Land Class for the new neighborhood code.

Assessing Neighborhood Base Rates
Land Class [Residential >
Commuercial
Exempt
Industral

| Open Space 3
gl 'ISpe:wt o |
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3. The left pane shows the list of current neighborhood codes. The right pane
outlines the details of each neighborhood code within the selected Land Class.
The top line of the right pane holds a plus sign (+) which denotes the row for
new code configuration. Enter data for the new neighborhood code created in
section 1. Once done, click Apply. *Note — The default sub-neighborhood code is

typically ‘A’
Aggeuting Nesghborhond Base Rates
ang Clnss ; Residental » ( Fimer Codes e
Ll ]

[ .' b GF ’
" t #H  Curce Car

fo  imEE

i

|

Section 3: Neighborhood Factors / Street Index

If the Neighborhoods found on the Land Lines in Classification & Land Information

are not the

same as your Assessing NBHDs, then do not complete these steps.

1. Click on Table Maintenance on the tree on the left side of the screen and select
Land Tables. Click on Neighborhood Factors.

vaon § Spplaation bolorer -8

Tabie Maintananca
Land Tables X o

s etV

e ot

Sep e

As3ea NepNOCN oo Base Azter
STe Adustment Tatvs

g Tepth Curve

270 S

>4 roex

g Curve Talie
Sowcis e

ioecy Calcy
Neighborhnod Factors
Blresge gLt

&5 Aegiors

Lang e

Froperty Balti g

2. In the top row next to the plus (+) sign, enter the new Code, Description, and
Adjustment Factor. Once complete, click Apply.
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Neighborhood Factors

Code Description

P TESTZ  Test Neighborhood 2
024D ARBORDALE

028C BANBURY CROSS

02GA FENTON MILL AREA

02NAC MICHAEL COMMONS

Nt Al Factor

1000

L0
|30

Lan
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You are here: Table Maintenance > How to Copy and Factor a Land Curve

OVISION

GOVERNMENT SOLUTIONS

How To Copy and Factor the Land
Curve

This document outlines the process to copy and factor the land valuation curves.

1. Open the Vision CAMA application.

2. Navigate to Table Maintenance > Land Tables > Land Curve Table

W an B AP AN Lapior e olx
| Vonbohe Maind wmmecse &
| Building Tables -
Land Yalsies

And Cam
And Tipes

Raglers
Aises Wegnnoreod Sase Nates

2o A shinprt Tige

A Qo (e
-Ang Use

e browes

Zenira
“andCanee Tase

Toecy Uve

Spper el sy
NeicHbndinors Feclime
Areagt D 5com

215 Regiors

nd Use

Mgty Faclaee

3. Identify the Target Land Class and Table ID for update.
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4. Inthe Copy / Factor Land / Acre Curves section, select the Source land class, table, and
desired curves. Once selected, click Copy.

Copy / Factor Land / Acre Curves i O — B
From Class Toble I sF Cumve Bﬁtum-_,
BResdentiol. .. ¥ k1 »| B AcaCurve —

5. The target curve(s) are then populated with the curves identified in step 4.

[Py S —" Canpy 7 Fautes Uomal / Aav Canves.
Feom Cem Tab Pl Cave T oG | Loy
A Sendertial T ; * @ ho Carin Farsr
 Dee—gton | l | |
2l l | [ 3

| N .

L]
LI Tow opr ‘

6. To accept the changes, click [##/ at the bottom right hand corner of the screen. To undo
changes, click lfe=

Land Curve Factoring

1. Open the Vision CAMA application.

2. Navigate to Table Maintenance > Land Tables > Land Curve Table
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3. Identify the Target Land Class and Table ID for update.
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4. In the Copy / Factor Land / Acre Curves section, select the land class, table, and curves to

factor, then click Factor.

Copy / Factor Land / Acre Curves
From Class Tabie 1 SF Curve [ FF Carve |
(RiResdenta) /[ XTestfactor  v| 4 Acre Curve

5. Review the confirmation prompt and click Yes to proceed.

Corfiorn Bwr were swnns Fector fae Clipn Rosidenteal , Todsde: Tatf widur
Do youwarh 1o pyos sk 7

Tl w |

6. Enter the desired factor for the target curve(s) and click OK.

= .
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7. Review the updated curve(s) and click OK. Then click s at the bottom right hand corner of
the screen to accept changes, or [+ to undo.
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You are here: Table Maintenance > Land Valuation Basics

OVISION

GOVERNMENT SOLUTIONS

Land Valuation Basics

This document outlines the foundational elements of Vision Land Valuation.

Disclaimer

A Please note that any alterations to the Land Tables will impact parcel valuation. There is no undo button to roll back changes once applied.
Please verify that a valid database backup is in place prior to altering land tables. Additionally, you may wish to print land rate reports for
reference before making changes. To do so, navigate to CAMA > Reports > Rate Files > Building and Land Rates, then select the desired reports
under Land Reports, then click View Report. The existing land curves may be printed by navigating to CAMA > Reports > Rate Files > Land Curve
Report, then selecting the desired criteria and clicking View Report.

Before We Begin

This documentation provides a basic overview of standard land valuation methods available in the Vision CAMA system and does not cover each
potential configuration. Methodology for Special Use and Alternate Land pricing, which addresses valuation of special land including Farm,
Forest, Pasture, etc. is excluded from this document. For advanced valuation, configuration assistance, or additional information please contact
Customer Support.

Gathering Land Valuation Components

The Vision CAMA promotes various land valuation configurations. To follow methodology for a specific parcel or land line, it is advised that the
user collect the following information as these items are referenced throughout this documentation.

Land Unit Type: Valuation methods are based largely in part on the unit type selected for each land line. The unit type may be viewed on
the Classification and Land Screen.

Bulding Clastficaten And Land Line Valuation

Bl # Line # Use Code Use Code Descrplian | L s Unit Type
» 1 1 1010 SINGLE FAM L7500, AC
Land Use Code: This is the use code assigned to the subject land line on the Classification and Land Screen.
Building Classificabion And Land Line Vakuation
‘Bidg # Line # Use Cade Code Deseriptior
> 1 11010 SINGLE FAM

Land Class: After identifying the land use code, navigate to Table Maintenance > Land Tables > Land Use and locate the code in the table.
The Land Class column shows the land class assigned to the use code.

Land Use
Filter by Land Class Fil
| Resaciential w | " Med-Use | | Show All Codes
Prim
Code Destription :r\d iand Bidg
5 ype Use
1016 SINGLE FaM R = = 10i0 -

Building Use: While in Table Maintenance > Land Tables > Land Use, note the Primary Building Use code. (This item is shown in the above
screen shot)

District: Navigate to Table Maintenance > Building Tables > Cost Use Codes and locate the Primary Building Use Code identified in the
previous step. Note the ‘Is Com’, ‘Is Cdu’, ‘Is Cdm’, and ‘Is Vac’ flags.
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i Cost Use Codes
Filker by Type Fitter Codes Like:
| &l Codes w! T

e I
110 SINGLE FAks * ND * NO ¢ NO v NO
If ‘Is Com’ is Yes, the commercial district / neighborhood is used.
If either ‘is Cdu’ or ‘Is Cdm’ is Yes, the condo district / neighborhood is used.
If ‘Is Vac’ is Yes and the Land Class is R, the residential district / neighborhood is used.
If ‘Is Vac’ is Yes and the Land Class is not R, the commercial district / neighborhood is used.
If all Is flags are No, the residential district / neighborhood is used.

Parcel Assessing Neighborhood / District: Navigate to Parcel > Legal Information > Account Information: Assessing Neighborhoods and
identify the appropriate district field based on the District explanation above.

Assersing heghborhoodt
Res Nbhg . 0045 = Comm Nihd : D040 = ; Condo Mbhd ;0070 et

Sub Neighborhood: On the Parcel > Classification and Land Information Screen, identify the Sub Neighborhood in the Land Valuation
Neighborhoods section. If the Land Class is R, the parcel uses the residential sub neighborhood, otherwise the commercial sub-
neighborhood is used.

Land Vaiuation Nesghborhoods
Res Nbhd 0045 Sub NBHD) 4 .
Comm Nbhd ; 0040 Sub NBHD| & -

Land Report

The Land.dat is a land valuation report outlining the land calculations for the current parcel. To access this report, select Utilities > Recalc Parcels
> Recalc Reports > Land Report. The calculation report will display in a separate window, showing the complete calculation for each land line
based on the current database configuration.

Land Pricing Methods

The subsequent sections detail the various land pricing methods in the Appraisal Vision CAMA software.

Land Curve Pricing

The primary land pricing methods used by Vision clients are the square foot and acre land curve pricing. The Vision CAMA allows for varying
degrees of granularity in development and assignment of land curves. Square Foot curve pricing is selected by setting the fand unit type to ‘SF.
Acre pricing is selected by setting the land unit type to ‘AC’. For acreage, also make sure that Use Acre Curve is enabled in ADMIN > Table
Maintenance > Parameters Tables > Valuation Switches: Land Calculation Switches. Additionally, the system defaults to use of land line acres for
unit price calculation, but enabling ‘Use Total Acres for Acre Curve’ will use the Total Acres for unit price calculations.

The Land Curves

Land Curves are configured in CAMA > Table Maintenance > Land Tables > Land Curve Table. One or more curves may be configured for each
land class.

*Note — If Mitas Land Curve by Site Index is enabled in ADMIN > Table Maintenance > Parameters Tables > Valuation Switches: Land Calculation
Switches, only the Residential and Commercial land curves are used in valuation. The residential curve is selected when a numeric site index is
applied to the land line. The commercial curve is selected when an alpha site index is applied to the land line.
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The image above shows a sample land curve screen. The top left pane shows the available land classes for which curves may be established. The
bottom left pane indicates the available curves within that class. Each class used should have at least one ‘Table’ entry. The default entry is
typically Table 1. Once the Land Class and Table ID are selected in the left panes, the right panes will display the associated Square Foot and Acre
curves.

The land curve is calculated using interpolation and is based on the economy of scale. The user may enter as many or as few size/price points in
the curve as desired so long as there is a 1 acre price in the acre curve, and a 43560 price in the square foot curve. When developing a curve, it is
recommended that the user run the Land Curve Report (CAMA > Reports > Rate Files > Land Curve Report) to ensure no pricing anomalies are
present in the calculation.

Finding the Curve

To calculate the land price before adjustments, first identify the land curve linked to the land line. To do so, locate the necessary components
outlined in the Gathering Land Valuation Components section of this document.

After locating initial valuation components, determine if the Assessing Neighborhood is part of a Region. Navigate to Table Maintenance > Land
Tables > Regions. Look for the Assessing Neighborhood in the table and note the assigned Region Code if present. *Note - This table setup is
optional, and unused by many clients.

Next, navigate to Table Maintenance > Land Tables > Assessing Neighborhood Base Rates. Select the appropriate Land Class from the dropdown
at the top of the screen.

in the left pane, select the appropriate Region Code if applicable, otherwise select the identified Assessing Neighborhood. The Base Rates by
Neighborhood window will display all entries for that Land Class / Assessing Neighborhood combination. Most databases will show a single entry
with a Sub Neighborhood of A. If multiple Sub Neighborhoods are used, locate the row with the appropriate Sub Neighborhood as indicated by
parcel data.

Upon identification of the target row in Assessing Neighborhood Base Rates, note the Table ID in the SF Curve, and Acre Curve columns. This
information indicates the Land Curve Table ID used for valuation.
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The Land Curve Equation

((LOW UNIT * LOW UNIT PRICE) + ({(HIGH UNIT * HIGH UNIT PRICE) - (LOW UNIT * LOW UNIT PRICE)) * (TOTAL UNITS - LOW UNITS) / (HIGH
UNITS - LOW UNITS))) / TOTAL UNITS

The above formula is used to calculate the land line value prior to any adjustments when either Square Foot or Acre pricing is used. The next
section will walk through a sample land line calculation. For the sample line, the parcel is using the residential fand class, and is set to use Table
ID 1 for both the Acre and Square Foot Land Curves.

Sample Land Line:

TS
ome  er = or
e 5 Rewahy * 13
e O™ N RN Tory IR0 Lo Cappirg €
2emng (W arT— ' ¥
[— Congtas Tacn 130
Dapth (] pdar B
Lindky: Vibrad il
it Type P * G
Loed Lt Typo

Appropriate Land Curve Screen for Parcel/Land Line:
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For the sample, the Unit Type is AC, so the calculation is based on the Acre Curve.

The subject lot size is 1.75 Acres which falls between 1.50 and 1.84 in the Acre Curve. Therefore, 1.50 is the Low Unit, 126000 is the Low Unit
Price, 1.84 is the High Unit, and 129600 is the High Unit Price. The 1 Acre Price is 115200. This data is used to determine the land line price
before adjustments as outlined in the calculations below.

The formula broken down:

Land Price = (LOW UNIT PRICE + {{HIGH UNIT PRICE - LOW UNIT PRICE} * ((TOTAL UNITS - LOW UNITS) / (HIGH UNITS - LOW UNITS)))) / TOTAL
UNITS

Land Price = (126000 + ({129600 - 126000) * ({1.75 - 1.50) / (1.84 - 1.50)))) / 1.75
Land Price = (126000 + {3600 * 0.7352941176)) / 1.75
Land Price = (126000 + 2647.05882336) / 1.75
Land Price = 128647.05882336 / 1.75 = 73512.60504192
Influence Factor = Land Price / 1 Acre Price
Influence Factor = 73512.60504192 / 115200
Influence Factor = 0.6381302521
Land Line Value (before any adjustments) = Lot Size * 1 Acre Price * Influence Factor
Land Line Value = 1.75 * 115200 * 0.6381302521

Land Line Value = 128,600 (Rounded per database settings)

Builging Qlassification And Land Line Valuation

Bidg # Line 8. Use Code  Use Cade Descoption ' Land Units | Unit Apprased Value

» soke s 0L SINGLERAMY L7500 A $126 460000

Building Lot Pricing

Building lot pricing is used when the user must assign a value based on the number of building lots. This is done by entering the number of
building lots in the land unit field and setting the land unit type to ‘BL. Base building lot pricing and standard lot size information is set for each
assessing neighborhood and may vary by land class.

Building Lot Table Setup

After locating initial valuation components outlined in the Gathering Land Valuation Components section of this document, determine if the
Assessing Neighborhood is part of a Region. Navigate to Table Maintenance > Land Tables > Regions. Look for the Assessing Neighborhood in the
table and note the assigned Region Code if present. *Note - This table setup is optional, and unused by many clients.

Next, navigate to Table Maintenance > Land Tables > Assessing Neighborhood Base Rates. Select the appropriate Land Class from the dropdown
at the top of the screen.
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In the left pane, select the appropriate Region Code if applicable, otherwise select the identified Assessing Neighborhood. The Base Rates by
Neighborhood window will display all entries for that Land Class / Assessing Neighborhood combination. Most databases will show a single entry
with a Sub Neighborhood of A. If multiple Sub Neighborhoods are used, locate the row with the appropriate Sub Neighborhood as indicated by
parcel data.

Upon identification of the target row in Assessing Neighborhood Base Rates, note the BL Base Price and Bldg Lot size columns. The BL Base Price
is the land unit price used when ‘Bl is selected as the land unit type. The optional Bldg Lot Size column allows the user to enter the square
footage for a building lot which is included in the total lot size calculation.
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The Building Lot Equation

TOTAL UNITS * BL Base Price

The above formula is used to calculate the land line value prior to any adjustments when Building Lot pricing is used. The next section will walk
through a sample land line calculation. For the sample line, the parcel is using the residential land class, and is set to use $75,000 as the BL Base
Price.
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Land Line Value (before any adjustments) = TOTAL UNITS * BL Base Price

Land Line Value = 2 * 75000

Ltand Line Value = $150,000 (Rounded per database settings)
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Linear Foot Pricing

Linear foot pricing allows the user to assign a unit price based on linear footage of frontage or waterfront. This is done by entering the total
number of linear feet in the land unit field and setting the land unit type to ‘FF’ for Front Footage, or ‘“WF’ for Water Front. The unit price for this
methodology is not table driven, therefore the site index must be set to ‘0’ before assigning a unit price.

*Note — Unit prices may be set individually, through the Mass Update utility, or through the Change Unit Prices utility.

The Linear Foot Equation

TOTAL UNITS * Unit Price

The above formula is used to calculate the land line value prior to any adjustments when Linear Foot pricing is used. The section below will walk
through a sample land line calculation.
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Land Line Value (before any adjustments} = TOTAL UNITS * Unit Price

Land Line Value = 200 * 75

Land Line Value = $15,000 (Rounded per database settings)
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Frontage/Depth Pricing

Frontage/Depth pricing allows for calculation of a unit price per square foot, with adjustments based on land frontage and depth. To utilize this
pricing method the unit type must be set to ‘FD’,

Finding the Frontage/Depth Pricing Data

To calculate the land price before adjustments, first identify the base price, frontage adjustment, and depth curve linked to the land line. To do
50, locate the necessary components outlined in the Gathering Land Valuation Components section of this document.

After locating initial valuation components, determine if the Assessing Neighborhood is part of a Region. Navigate to Table Maintenance > Land
Tables > Regions. Look for the Assessing Neighborhood in the table and note the assigned Region Code if present. *Note - This table setup is
optional, and unused by many clients.

Next, navigate to Table Maintenance > Land Tables > Assessing Neighborhood Base Rates. Select the appropriate Land Class from the dropdown
at the top of the screen.

In the left pane, select the appropriate Region Code if applicable, otherwise select the identified Assessing Neighborhood. The Base Rates by
Neighborhood window will display all entries for that Land Class / Assessing Neighborhood combination. Most databases will show a single entry
with a Sub Neighborhood of A. If multiple Sub Neighborhoods are used, locate the row with the appropriate Sub Neighborhood as indicated by
parcel data.

Upon identification of the target row in Assessing Neighborhood Base Rates, note the Front Base Price, Front Adj, and Depth Curve. The Front
Base price is the starting unit price, which is subsequently adjusted based on the Frontage Adjustment and the Depth Curve.
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The Frontage Adjustment

Frontage adjustments are configured in CAMA > Table Maintenance > Land Tables > Size Adjustment Table.
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The Depth Curves

Depth Curves are configured in CAMA > Table Maintenance > Land Tables > Land Depth Curve.
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The image above shows a sample land depth curve screen. One or more depth curve may be entered. Curves are differentiated by their Curve ID.

The default entry is typically Curve ID 1.

The Land Depth Curve Equation

Full Calculation: Total Units * (Base Price * Frontage Adjustment * Depth Adjustment)

Frontage Adjustment: LOW FACTOR + {(HIGH FACTOR — LOW FACTOR) / ((HIGH SIZE * 100} - (LOW SIZE * 100}) * (ACTUAL FRONTAGE — (LOW
SIZE * 100))

Depth Adjustment: ((LOW DEPTH * LOW ADJUSTMENT) + {{{HIGH DEPTH * HIGH ADJUSTMENT) - (LOW DEPTH * LOW ADJUSTMENT)) *
(ACTUAL DEPTH - LOW DEPTH) / (HIGH DEPTH - LOW DEPTH))) / ACTUAL DEPTH

The above formula is used to calculate the land line value prior to any adjustments when Frontage/Depth pricing is used. The next section will
walk through a sample land line calculation. The Assessing Neighborhood Base Rates table is configured to use $2.30 as the Front Base Price, the
LND adjustment curve, and Depth Curve ID 1.

Sample Land Line:
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Appropriate Frontage Adjustment Screen for Parcel/Land Line:
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The subject frontage is 175 feet which falls between 1.50 and 2.00 in the Frontage Curve. (Note that the frontage adjustment table is developed
based on Frontage / 100.) Therefore, 1.50 is the Low Frontage, 1.21 is the Low Factor, 2.00 is the High Frontage, and 1.00 is the High Factor. This
data is used to determine the Frontage Adjustment as outlined in the calculations below.

Frontage Adjustment: LOW FACTOR + ((HIGH FACTOR — LOW FACTORY) / ((HIGH FRONTAGE * 100) - (LOW FRONTAGE * 100)) * (ACTUAL
FRONTAGE — (LOW FRONTAGE * 100}))

Frontage Adjustment = 1.21 + ((1.00 — 1.21) / {(2.00 * 100) - {1.50 * 100)) * (175 - (1.50 * 100))
Frontage Adjustment = 1.21 + {—0.21 / (200 — 150) * (175 — 150))

Frontage Adjustment = 1.21 + (— 0.21 / (50) * (25))

Frontage Adjustment = 1.21 + (- 0.105)

Frontage Adjustment = 1.105

Appropriate Depth Curve Screen for Parcel/Land Line:
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The subject depth is 225 feet which falls between 200 and 250 in the Depth Curve. Thus, 200 is the Low Depth, 1.00 is the Low Adjustment, 250
is the High Depth, and 1.10 is the High Adjustment. This data is used to determine the Depth Adjustment as outlined in the calculations below.

Depth Adjustment: {{LOW DEPTH * LOW ADJUSTMENT) + {{({HIGH DEPTH * HIGH ADJUSTMENT) - (LOW DEPTH * LOW ADJUSTMENT)) *
{ACTUAL DEPTH - LOW DEPTH) / (HIGH DEPTH - LOW DEPTH))) / ACTUAL DEPTH

Depth Adjustment = ({200 * 1.00) + ({(250 * 1.10) - (200 * 1.00)) * (225 - 200) / (250 - 200))) /225
Depth Adjustment = (200 + ({275 - 200) * 25 / 50)) / 225
Depth Adjustment = (200 + (75 * 25 / 50)) / 225
Depth Adjustment = (200 + 37.5) / 225
Depth Adjustment = 237.5 / 225
Depth Adjustment = 1.0555555556
Full Calculation:
Land Line Value {before any adjustments) = Total Units * (Base Price * Frontage Adjustment * Depth Adjustment)
Land Line Value = 39375 * (2.30 * 1.105 * 1.0555555556)
Land Line Value = 39375 * (2.6826944)

Land Line Value = 105,600 (Rounded per database settings)

Budding Clasuficetion And Land Line Valuabon

Bidg ® Line 81 Use Code Use Code Oescnpbion Lang Unas  Ured Type Appeaised Value

b D 1 1010 UNGLE R 5140000 D $10% 800.00
T
Land Acres 0903926 Apprased $105.600.00

0.0000
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*Note — The Total Units field is the product of the Frontage and Depth values. This may be overridden for final calculation by checking the

‘Override Land Units’ box, which will open the Total Units field for manual update.
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Land Line Value (before any adjustments) = Total Units * (Base Price * Frontage Adjustment * Depth Adjustment)

Land Line Value = 40000 * (2.30 * 1.105 * 1.0555555556)
Land Line Value = 40000 * (2.6826944)

Land Line Value = 107,300 (Rounded per database settings)

Bulding Cassication And Land Line Valustion
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The next section outlines the various available land adjustments.
The following simple parcel is used for ease of explanation:
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Site Index

The site index table is configured in Table Maintenance > Land Tables > Site Index. The primary function of the site index is to enable/disable
table driven land pricing. Adjustments may also be configured based on street ranking, which is often used in jurisdictions lacking clear
neighborhood delineation. This may also be used in conjunction with neighborhood factors. The default residential site index is 5, and the
default commercial site index is C. Please reference prior notes regarding Mitas Land Curve by Site index in the Land Curve Pricing section of this

document.

Below is a sample Site Index table for demonstration.

When a site index is assigned to a Land Line, the Unit Price and Influence Factor become read only.
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For the sample below, the land curve price for 1 acre in this database is $75,000. Because site index 5 has an influence of 1.100, the Unit Price of
$75,000 is factored by 1.10 resulting in a final Unit Price of $82,500.
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Site Index O allows for manual pricing when a line requires departure from table driven valuation methods. When the site index is changed to 0,
the unit price and influence factor become enabled for user edit.

*Be sure to set the Influence Factor to 1 when manually updating the Unit Price.
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The land neighborhood table is configured in Table Maintenance > Land Tables > Neighborhood Factors and allows for land adjustments based

on neighborhood delineation.

Some municipalities opt to use the Assessing Neighborhood as the Land Neighborhood. This functionality may be enabled in ADMIN > Table
Maintenance > Parameters Tables > Valuation Switches: Land NBHD Matches Assessing NBHD. When this is enabled, the Land Neighborhood
field is auto-filled with the Assessing District and the field becomes read only. The user must ensure all Assessing Neighborhood codes are also
present in the Neighborhood Factors table to avoid calculation errors. When this option is disabled, the Land Neighborhood field is enabled for

user edit. Some jurisdictions opt to assign a neighborhood adjustment to only primary land, where others assign the neighborhood to all land
lines. This is uitimately the decision of the municipality.
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Below is an excerpt from a sample Neighborhood Factors table for demonstration.

Selecting Sample 1 as the neighborhood for Land Line 1 populates the Nbhd Adj field with 1.1 which matches the adjustment factor from the
table. Selecting Sample 2 for Land Line 2 results in a Nbhd Adj of 0.9. Land Line 3 will remain constant with no neighborhood assigned.
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With the Neighborhood Factors, the land now calculates as shown beiow.

Buiding Classficstion And Land Line Valation

Bldg® Line ® Use Code Use Code Descrpton | Land Ussts Unet Type Lindt Price  Nobd | Nbha Ady: Apprivsed Vaiue

» B

Land Acres

Special Calcs

11000 SO Usben e L0000 AL

2 100R S6D - Urben fles 50000 AC

3 100R SED - Urban Res 1000000 AC
pi ] Appeasred

$.00000 0002

$00.00

- -83,50000
0500 22.500.00
1000 50.000.00

£155 600.00

The Special Calcs table is configured in Table Maintenance > Land Tables > Special Calcs and allows for table driven land line adjustments such as

topography, water influence, and utility adjustments.

One or more special calcs may be assigned to each land line, and valuation impact is based on configuration in the Special Calcs table. The
sample table below is used for subsequent demonstration. Please note that codes and descriptions used are present for the purposes of

demonstration only.

WTAD)
FYTREP

FVUAD] *

FVUREP

Unit Type ' Desenption

N Factoe Total Adjustment

. Factor Unit Adjustmant

. Flat Vahue Total Adustment

. Flat Vahie Total Replace
Flat Value Unit Adgustmens

" Flat Value Uit Replace

Affect oo Usit Pricing DM:!';-I Price Adjusument | Factor
ADNST YES v 0 075
abust NO = ¢ 075
ADASY vi¢ - 10000 100
REPLACE ¥ES§ - 10000 100
ADNST KO - 10200 100
REPLACE NG e 10000 100
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Table Explanation:

Code: This is the special calc code.

Unit Type: This indicates for what unit type the code is available. If AC is entered, the calc will only be available for land lines having AC as
the unit type. Entering * makes the code available for all land unit types.

Description: This is the special caic description.
Affect on Unit Pricing: This instructs the calculation to either ADJUST or REPLACE the land line value with the table defined value.
Does this Affect Total: If YES the adjustment impacts the total value, if NO then the adjustment applies to the unit price.

Price Adjustment: Entering a unit price will either ADJUST or REPLACE the indicated value with the value in the Price Adjustment column.
If no Price Adjustment is to be used, the column is populated with 0.

Factor: Entering a Factor will adjust the indicated value with the table defined factor. If no Factor is used, the column is populated with
1.0.

Special Calc Samples

Land Line 1 from the sample parcel with a Neighborhood factor of 1.1 is used for the demonstrations below.
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FCUADJ: Factor Unit Adjustment (Factor applied to the Unit Price}
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FVUADJ: Flat Value Unit Adjustment {Unit Price adjusted by Price Adjustment)
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FVUREP: Flat Value Unit Replace (Unit Price replaced with Price Adjustment)
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FVUREP & FCUADJ: Flat Value Unit Replace & Factor Unit Adjustment
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*Note - Special Calc rounding precision may be set in ADMIN > Table Maintenance > Parameters Tables > Rounding.

Property Factor Adjustments

Property Factor Adjustments allow for property factors assigned at the parcel level to impact land line calculations. These adjustments are

configured in Table Maintenance > Land Tables > Property Factors.

Pruogerty Fatar

| Property Factor ; * Drsivgs % dcpustmers % Adpatmes s § btpramera Agery o Tot LEnd e LOmy  dpgay ta ey

> WL - { - . - [ ]
07 | W

Table Explanation:

Code: This is the property factor code.

Description: This is the property factor description.

% Adjustment: This is the adjustment factor if ‘Is $ Adjustment’ is unchecked.
$ Adjustment: This is the adjustment amount if ‘Is $ Adjustment’ is checked.

Is $ Adjustment: Indicates whether an adjustment factor or dollar amount is applied.

Aoy to Mas

Apply to Total: If checked the adjustment impacts the total value, if unchecked then the adjustment applies to the unit price.

Land Line 1 Only: If checked, the adjustment only applies to Land Line 1. If unchecked, the adjustment applies to all land lines.

Apply to Res: If checked, the factor applies to Residential parcels.
Apply to Com: If checked, the factor applies to Commercial parcels.
Apply to Condo: If checked, the factor applies to Condo parcels.
Apply to Main: If checked, the factor applies to Condo Main parcels.
Apply to Vacant: If checked, the factor applies to Vacant parcels.

Property Factor Sample

The image below shows the sample parcel when Code 14: Topo Adj Sample is selected as Property Factor 1. Note that only the Land Line 1 total

is iImpacted by the code as per table settings.

Apyey 0 vacare
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Busiding Classficaton And Land Live Valoation
g ® Une ¢ Use Code, Upe Code Descrption. Land Lns Unit Type. Ui Price  Appremed Valoe:
» ] $O100R  SHD < Urban Res 2+ 10000 ALty THOMD0 750000

1 2 100R 3FD « Urban Res 30000 AC 500000 2500000
i 3 1008 SFO - Urbwn Res WO0000 AL S0 5050000
Land fcren 106 Appraand $172 50000

The next sample shows the impact of adding Code 02: Gravel to the Street/Road property factor.
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Acreage Discount

Acreage Discount Factors provide adjustments based on lot size. This is enabled in ADMIN > Table Maintenance > Parameters > Valuation
Switches: Use Acreage Discount. Once enabled, determine if acreage discount factors will be applied based on Total Acres, or individual Line
Acres. The system defaults to Line Acres but enabling ‘Use Total Acres instead of Line Acres’ allows the application of the discount factor to all

approved lines when the total acreage warrants adjustment based on table configuration. Individual Land Lines may be excluded from acreage
discount by checking ‘Exclude from Acreage Discount’ in the Land Details screen.

Caicuiatton Setings & Switches

snd Cakulation Switches

‘] Mitas Land Curve by Site Index

V) Use Acre Curve

W Lonvert Land Line Totad tand Lintts Ta Aces

| enby Zone Code against table

#lincreare Land Cuive Scale and Precaion

tand NBRD Matches Assatsing NBHD

F Version 6.2 Lend Speciat Use Calc

Wl Use Acreage Drscount e
e Taral Acres For dere Curve

¥ Ue Front Foat Cune /
Asreage Drccunt Cptions

I Use Toah Acres tand of Line Acres

The Acreage Discount Table

Acreage Discount Factors are configured by Land Class in CAMA > Table Maintenance > Land Tables > Acreage Discount.
*Note — The Acreage Discount factor is applied based on table entries, not interpolation. This means that if the subject acreage falls between two

table entries, the closest table entry less than or equal to the subject acreage is used for discount factor assignment. Based on the sample table
shown below, a subject having 115 Acres will receive an acreage discount of 0.97.
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Acreage Discount Sample

The image below shows the valuation when ‘Use Total Acres instead of Line Acres’ is enabled in Admin. The parcel has a total of 106 acres,
resulting in an acreage discount adjustment of 0.97. Additionally, Land Line 1 is excluded from Acreage Discount, therefore the factor is only

applied to land line 2 and land line 3.

Guikdling Classficaton And Land Line Velustion

i 8] Lt 91 Use Code Use Code Duscsiption Land Units : Unit Type Unit Price [Appeaned Vate |

» ¥ 1 1008 SFD - Urtem R 10000 AC 500000
2 00R SFO - Urban Res 3.0000 A< 500000
3 100/ SFD - Urban Res 1000000 AC S0

Price Adjustments

7500000
24,3000
48,500.00

Price adjustments allow for assignment of up to eight free-form adjustments to each land line. These adjustments are enabled first in ADMIN >
Table Maintenance > Parameters Tables > General by checking the boxes next to the desired ‘Use Lnd * as PriceAdj’, then entering the maximum
value in the associated Max Val field. Once enabled, navigate to ADMIN > Configurations of Vision 8 > Real Estate > Land Details and assign

labels, a pick key, and a sort order to each desired field.

Once enabled, the adjustment fields appear on the Land Details screen.
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Adpatrant 3 Agiamnars |

Adpuatrasmi Adgrmra 8
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|
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|
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|
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Adjustment fields are paired. The first field allows for selection of an adjustment type or note from the assigned pick list. The second field stores

the desired adjustment.

Adsasmet | e Adgmtmars §: -
ity T —"_ Aprntat 8 .
At 3 . Adpermer 7 .
Adpastrane 4 = Agumant .
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When multiple adjustments are applied to a land line, they are multiplied together to obtain the Total User Value Adjustments, which is then
used in the Total Adjustment Calculation. The relevant portion of the Land.dat showing the adjustment caiculation is shown below.

Condition Factor

o—_—,:—_- v gt Y i
e ume
i St

Use Cacer 100 W0 - Urksan Ry ** Lanat Type
Zonmy Unh Price o0
franage Tt fpcim & X0
Lot Comtien Fax 100
Tou (s o ] LA T
Units oo Nbed &y
Yok Type |y s e A
Afpabmant | b lawyre Apewrend 130 Dfuaiveans
et § 5 Bl Mptrart 09 Adpatmant 6
bt 1§ Sovpie Mstmnet 110 Adpesusst T
Adpstmrt 8 5 Sonphe Apmimerd " 093 Adpatmers §:

Spuniel Toka

L

Spal o : =

E] Gvaasictn Appronad Lo Votun:

Totais.
ypard |90 Asemevd
it Ak L]

User Yalue Adatments 1 = 1.50

User Value Adustments 2 = 0.90¢

User Value Adustments 3 = 110

Usar Value Adustments 4 = 075

Total Uner Value Adustments = 1.11375000

N N WSS TY :”ﬁ_'

The condition factor field allows for manual entry of an adjustment factor. This is typically done when an atypical adjustment is warranted, and

alternate adjustment methods do not work. Users then document the adjustment in the Notes field.
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[ e h e 0w
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Laeng Lnin Priey TS000.00
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P TN Y
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Putting Adjustments Together

The next section outlines the land calculation when multiple adjustments are combined. The following sample focuses on Land Line 1 with the

following criteria:
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1 Acre Land Curve Unit Price: $75,000
Neighborhood 0002: Factor 0.90

Site Index 5: Factor 1.10

Acreage Discount Factor: 0.97

Special Calc FCUADI: Factor 0.75

Special Calc FVTAD): Adjustment $10,000
Price Adjustment 1: Factor 1.05

Price Adjustment 2: Factor 1.15

Topo 1 Code 14: Factor 1.30

Street/Road Code 02: Adjustment -$5,000

Tt wl

[T [
1 : o buten 5 Resioe 710
e LI DR
Ty Unk frice
Fromtage IBmce Facus
[ ] Comdilion fex
Total uam 1 Nebed O Laepie
Unis: 10000 Wbl b
Un Type A Lerwy " S At
Adtraet ] b el Aoves v (B Astnan 3
At 1§ Saephy Afusvam ¢ (19 Agimen 4
Arronss | Adpustnera 7,
Adjustouat &) Adjortme 8,

Spoviet Calcy 7 FCLIADS IYTAD!

Mot Sampile Cancltion Facar

) chuie P Acusage ot
Soeonl e y . »
3 Ovarid Appssion] L Valve
Overrin Asasuawd | Line Vs
Tomh
dgproioed  9iWIC Avsammt
Ferat e e

Detailed calculation for Land Line 1 above derived from the land.dat report:

Land Use Code = 100R

Base District = 0001

2600 3ok ke o ke ok ke e e s e ol o 3K ok o e o ok sk ok sk kR R R R R ok
Find the region for a group and district

Land Group =R

Region = District, Region not defined

Base Sub District = A

Z Contour = 0.0000

District Standard Size = 1

District Base Price Size = 1.00

District Size Adjustment = NSZ

Land group based Value Source = C

LIS 2 E2 S LIS RS2 0TI 2T
Calculate the land unit price using site index land curve method
Initial Curve Class R

Land Curve by Site Index Option

Site Index 5 New Curve Class R

Initial Unit Price 82500.00
Interpolate/Extrapolate from curve table id 1
Calculate Acre Land Curve

Entered Units 1.0000

Entered Unit Price 82500.00

Get 1 Acre Price

1 Acre Price for Acre Curve = 75000

Exact Match Found

Land Price 75000

Unit price is shown as whole acre price

New Land Price 75000 * 1.100

New Land Price 82500.000
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New Unit Price 82500.000

New Influence Factor 82500.000 / 82500.000

New Influence Factor 1

District pricing based unit_type value = 82500.000

3 % 3 ok o ok ok ok ok ok ok ok ok ok sk e ok ok ok ok ok kR ok R sk ok ok Rk A OE R R ok R Rk ok Rk Rk ok ok

Special Calc FCUADJ adjusts unit price

Special Calc FCUADI adjusted unit price = unit price (82500.00) + Adjustment (0) * Factor {0.75)
Special Calc FCUAD] adjusted unit price = 61875.00

Total property factor adjustment = Line 1 only adjustments (1.300) * Other adjustments (1)
Total property factor adjustment = 1.300

Unit price with property factor adjustments applied = 61875.0000 * 1*1.300

Unit price with property factor adjustment applied = 80437.5000000

Unit price with property factor sum adjustment applied = 61875.0000 + Line 1 Only {0) + Other Adjustments (0)
Unit price with property factor sum adjustment applied = 61875.0000

Acreage discount 0.9700

Acreage discount based on 106.0000 line acres

User Value Adjustments 1 =1.050

ok o ok ok ok Ok ok ok s O 6 3 ok K ok ok K ok ok ok

User Value Adjustments 2 = 1.150

ko ok Ok ok R R OR K K

Total User Value Adjustments = 1.207500

ok ok ok ok ko ok a3k ok oF o ok ok K 3k ok koK Kok

Total adjustment a =0.9700 * 1 * 1.02 * 0.900 * 1.207500

Total adjustment a = 1.075230450000000

Land Value = 86486.40000000000 * 1.0000

Land Value Rounded = 86500

9 3K 3 3K 3k ok 3K ok o ol ok ok ok ok ok o ok o ok 3 ke ok ok ke ok 0K Sk dk 3Rk R R R ok ok ok K ok sk ok ok k.

Special Calc FVTADI adjusts total land price

Special Calc FVTADI adjusted total land = land price (86500) + Adjustment {10000) * Factor {1.00)
Special Calc FVTADJ adjusted total land = 96500.00

Special Calc Land Value = 96500

o e ok ok o ok ok ok e ke ke ok ok o o ok ok koK

Total Value factor adjustment = Line 1 only adjustments (1) * Other adjustments (1)

Total Value property factor adjustment = 1

Total Value with property factor adjustments applied = 96500 * 1*1

Total Value with property factor adjustment applied = 96500

Total Value with property factor sum adjustment applied = 96500 + Line 1 Only (0) + Other Adjustments {(-5000)
Total Value with property factor sum adjustment applied = 91500

© 2018 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800} 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Table Maintenance > How to Add a Subarea Code

OVISION

GOVERNMENT SOLUTIONS

How To Add a Sub-Area Code for Sketches

This document demonstrates how to add new sub-area codes to Vision for use in the Sketch tool.

From the left-hand menu tree in CAMA select Table Maintenance > Building Tables > Subareas.

Fle Cants Utktim Welp

# ‘RN

The screen will display two panes. The left-hand pane contains the list of available codes for use in the sketch module. The right-hand pane
displays the valuation configurations for the code selected in the left-hand pane. The subarea code is available to all mode! types listed in the
Model column of the left-hand pane. Appraisal Vision allows classic effective area pricing or the square foot pricing option for each subarea code
/ model combination.

Effective % reflects the percent of the subarea’s calculated gross area that will be applied to value if Use Square Foot Price is
unchecked.

SFLA reflects the percent of the subarea’s gross area that is calculated as living area. This total does not impact valuation unless
configured to do so through the Cost Model.

Square Foot Price denotes the unit price multiplied by the subarea’s gross area which is added to the value calculation if Use Square
Foot Price is checked.

Use Grade indicates whether the subarea value is impacted by Grade factors and other multipliers present in the cost model when Use
Square Foot Price is checked. When Use Grade is checked, the value is added prior to applying multipliers. When unchecked, the value
is added after application of multipliers.

Classic Effective Area Pricing

*For this method, the Use Square Foot Price is unchecked. Any data listed in the Square Foot Price or Use Grade columns will not be
included in the building valuation.

The first example below demonstrates the sample configuration for Code BAS (First Floor Finished). It is applicable to all model types, will
value at 100% of the gross area per the Eff. % column, and the SFLA column indicates that it calculates living area at 100% of the gross area.
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The second example FHS (Half Story) is also available for all model types but lists an Eff. % of 50, resulting in 50% of the gross area applied to
the base rate. The SFLA column indicates that 50% of the gross area is added to the square foot of living area total.

L Copy Fecms
Foom Code
O O Loy
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® bt 205
Square Foot Pricing

*For this method, the Use Square Foot Price is checked. Any data listed in the Eff. % column will not be included in the building valuation.

The first example shows the configuration for Code PTO (Patio). It is applicable to all model types, will value at $5 per square foot of
calculated gross area per the Square Foot Price column, and the value is not impacted by any multiplier cost models because Use Grade is
unchecked. The SFLA column indicates that no area is added to the SFLA total for this subarea.
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The second example shows the configuration for Code DCK (Deck). It is applicable to all model types, will value at $10 per square foot of
calculated gross area per the Square Foot Price column, and the value is affected by multiplier cost models because Use Grade is checked.
The SFLA column indicates that no area is added to the SFLA total for this subarea.
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Adding a Subarea Code

Click in the Code field next to the plus sign (+) at the top left-hand corner of the left-hand pane.

Subareas:

= ¥
Codf::npuhon
DCK  Deck

Then Enter the Code (up to 6 characters) and a Description (up to 40 characters)

Subareas:
Code Description
7 TESTCD lhmple Subarea Code ]

e ~

o S St P

With the new Code selected in the left-hand pane, enter the desired factors in the right-hand pane. Create one entry for each Model for

which the code is permitted.

Medel £ff. % SFUA Income Ares Square Foot Price Use Grace Use Square Foot Price

Use the drop-box provided to select the appropriate Model type.

et I % WA e Sas Sopatrn Fimt Poun Vs Comde s Lponrw ot Prus

» | Al - .

00: Vecort

[ Aanidpatal
D2; Malyile Howay
0% Mudv-Famdy
Dex Commlts Maim
0% Aos Condor
& Com Corxdo
S Commercal
% Sav Station
9% Indlustrial

If using Classic Effective Area Pricing for this Code and Model, uncheck Use Square Foot Price, then enter the Eff. % factor, and SFLA factor.
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Maodel B, % SFLA |Income Ates Square Foet Price Use Geade Use Square Foot Price

hs, - - - -

01 Resdentisl  ~ 100 100 000

If using Square Foot Pricing for this Code and Model, check Use Square Foot Price, enter the SFLA factor, the Square Foot Price (rate), and
then indicate if the value will Use Grade factors and other multipliers configured in the cost model.

Maodel BN SFLA |Income fues Sguare Foolt Pree Uie Grade Lite Square Foot Price

- L] L
0% Reudentsl ¥ o 000 $20.00 + o

Click Apply in the lower right-hand corner of the screen to save the new code.

[Aoply| Revert)

Note: Factors may also be copied from an existing subarea code as demonstrated below.

Click in the Code field next to the plus sign (+) at the top left-hand corner of the left-hand pane.

Subareas:

— ¥ |
{ C@dfwmwm

DCK  Dreck

Then Enter the Code (up to 6 characters) and a Description (up to 40 characters)

Subsiess
Lede Descrption
SAMPLE I'_-.1rr-|;.: Subares Copy Codd ]
RES RES Area

With the new Code selected in the left-hand pane, select the row with the plus sign (+) in the right-hand pane.

Cogy Factors
From Code
ADF Of - [Copy
fy: EH % SFLA | lncomse drss Sauare Foot Precs Live Grade Use Square Foot Prue
- - L L
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In the From Code drop-box, select the source code containing the factors you wish to copy to the Code selected in the left-hand pane and
click Copy.

CON: Canopy, detached
CLP: Loading Platform, Finished
COM: COM Area

Review the source and target codes for the update and click Yes to proceed.

[oh ST M AR | Do g S O, Ca i e e S
TCanh 6 Tl 1 L la o : AT

Canfitm copy of table entries from BAS to SAMPLE

Da you wish to proceed?

[ v ] No

The new Code factors now match the source factors.
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Click Apply in the lower right-hand corner of the screen to save the new Code.

," Note:To remove an entry from a table, highlight the record and select the Delete key on the keyboard. A confirmation message will
appear. Choose Yes to delete the record, or No to cancel the deletion.

Warning: Deletion of codes in use in the CAMA application may result in undesired value changes. Please ensure you have a valid
database backup prior to deletion.
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' Delete Record )

, You have selected 1 record for deletion.
Choase Yes to delete the record or MHo to exit.

T

If Yes is selected but the Subarea Code is in use, a message will appear indicating that the subarea cannot be deleted. Parcels using the
indicated subarea code may be located using the report wizard.

L3 |

Subares in use ke = )

The selected subarea is in use (1) and cannot be deleted.

OK- )

?"’§» Note: The Delete process works the same way, whether deleting a Subarea code entirely, or any individual Factor assigned to a

" Subarea code

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Table Maintenance > Understanding the Building Size Curve

OVISION

GOVERNMENT SOLUTIONS

Understanding the Building Size

Curve Calculation

This document will explain the Table Maintenance, Building Tables, Size Curve Calculation. This
document, in conjunction with the associated spreadsheet, demonstrates the size curve calculation.

1. Go to the Utilities > Recalc Parcels > Recalc Reports > Cost Report.

[ Usiites | Help
Job Queue |9 [ 3G QEE & . ~ Value Fre

|

L1

| Recalc Current Parcel
Fecnis Paroed lob Cuevs

| Recalc Select Parcels

Recalc Parcels »
Parcel Administration J
Utilities ’
Sales Analysis Utilities

Comp Snapshot Utilities ’ |
Income Utitilities * on —

» .l. _| Recalc Reports

land Report

2. This will open to the Cost Report screen. This screen shows the calculated Size

Adjustment.
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QUTPUT FROM NEW COST MODELING ENGINE
REPORT GENERATED ON 13-Jan-2016 AT 07:38

rrsermeerrsxrBuilding #1 Calc Startrrrssrsroos
Cost Calculation for pid, bid = 12779, 12779
Account Number = 046B60ONNO 1000

Use Code = 210R

Cost Rate Group = SIN

Model ID: = PO1

Section #1

Section Use: Single Family
Base Rate: 54.33

Size Adjustment: 105463 € j

Effective Area; 2750

*Note — To more easily follow the steps below, please reference the associated Excel document:
V8_Misc_Calcs.xlsx.

A screen shot of the worksheet is also available at the end of this document.
3. To determine the size adjustment the user must first gather the pertinent variables.

a. Parcel > Building Information > Construction Details > Style

Building Information 2 - - ; —

Construction Detaits | Model Residentiat
Depraciation

J’P':Q\ s EETE | Grade . : -1 [
g N et | Style 135: 2 Sty Transitional |

b. Parcel > Building Information > Depreciation > Effective Area

Section Summary

Group SIN Effective Area 2750

Base Rate  54.33 RCN 742

Eff Base Rate $80.68 Bldg % Good

Net Other Adj $136,876.85 RCNLD

Living Area 2750
|Code lfDiascm:ltiw:m Gross Living Eff Area
AVGAR Garage, Average Quality 572 0 0 |=
DECK  Deck, Average Quality 154 O 0

FINLA  Finished Living Area 2750 2750 2750

¢. Table Maintenance > Building Tables > Style Codes — Find the indicated Style
code (3a) from above, and determine the Size Adjustment Code
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Table Maintenance

Building Tables [
Cost Use Codes

Cost Group Rates
Building Made| Types
Style Codes

Si. Listments

Su

0B

OBXF ondition
EYB Depreciation
Depreciation Tables

# mortized Exemptions

Style Codes
Stye [A-AlproperyTypes ||
Condo Condo Min | Max :

Code Description Res Cmrd Unit | Main Vacant Stovias | Stories Sze Ad)  Std Sae
o
> 35 25t Trensibona VS N0 NO  NO  NO o 9905 <] 410

d. Table Maintenance > Building Tables > Style Codes — Find the indicated Style
code (3a) from above, and determine the Standard Size

Style Codes

= r—
Styte: | A - All Property Types | ¢

g Condo Condo Min  (Max |

Code Description Res Cmrel Unit | Main Vacant Stories Stormts.‘u’ Std Size

» 35 25ty Transitional ¥ES NO NO NO - NO 0 999 8d2E l_‘l_'I_mJ

e. Table Maintenance > Building Tables > Cost Group Rates — Find the indicated
Style Code (3a) from above, and determine the Size Adjustment %

Table Maintenance

Building Tables 2
Cost Use Codes

Cost Group Rates
Buildi el Types
Style

Size

Subareas

OBXF Codes

OBXF Grade/Condition
EYB Depreciation
Depreciation Tables
Amortized Exemptions
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Cost Group Rates

Factor Base Rate
Select Group:
|—<ALL> I
Group | Style | Description Base Rate Dpr 5| o Max Dpr | Max Age
Table Adj% Life
P SIN 35 2StyTransitional 5433 4 | 100' 80 99 9

4. With known variables, the first calculation determines the Size Percentage

a. {10,000 / Standard Size) * [Effective Area * (Size Adjustment % / 100)]

Example:

(10,000/ 4,100) * [2,750 * (100 / 100)]

Size Percentage = 6,707.317073

5. For future calculations, divide the Size Percentage (SP) by 100

a. (Size Percentage / 100)

Example:

(6,707.317073 / 100)

Size Percentage Lookup = 67.07317073

6. Table Maintenance > Building Tables > Size Adjustments - Find High Units

a. 1 Value Higher than 5a — (Size * 100)

Vision 7 Application Explorer

Table Maintenance

£«

Building Tables
Cast Use Cedes

Cost Group Rates

Buiiding Mode| Types

Style Codes :__ D
Subareas i
OBXF Codes

Size Adjustments
OBXF Grade/Condition

2

F

e Size Adjustments:

| BOZ2E

Code Description
BO2C
BO2D
> o[Bee 802€
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Size just Factor

1.0600
6800 1.0500

Example:
(68 * 100)

High Units = 6,800
7. Table Maintenance > Building Tables > Size Adjustments - Find Low Units

a. 1 Value Lower than 5a — (Size * 100)

1.0600
68.00 1.0500

Example:
(66 * 100)

Low Units = 6,600
8. Table Maintenance > Building Tables > Size Adjustments - Find High Price

a. 6a corresponding factor — (Adjustment Factor)

Size Ady tor

66.00

6800] 10500

9. Table Maintenance > Building Tables > Size Adjustments - Find Low Price

a. 7a corresponding factor — (Adjustment Factor)
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Size actor

6600 0600
68.00 500

10. Calculate High Units minus Low Units

a. (ea—7a)

Example:

(6800 — 6600)

High Units Minus Low Units = 200
11. Calculate High Price minus Low Price

a. (8a—9a)

Example:

(1.05 - 1.06)

High Price Minus Low Price = -0.01
12. Calculate Price divided by Units

a. (11a/10a)

Example:

(-0.01) / (200)
Price Divided by Units = -0.0000500000000000
13. Calculate Size Percentage — Low Units

a. (4a-7a)

Example:

(6707.317073 — 6600)
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Size Percentage = 107.3170732

14. Calculate Size Adjustment

a. [(12a * 13a) + 93]

Example:

[(-0.0000500000000000 * 107.3170732) + 1.06]

Size Adjustment = 1.05463

Example Worksheet

Calculate Size Aqtistmem
Step Variables
3a [Style 35
3b Effective area S 2750
3¢ Size Adjustment Code r BO2E
3d |Std Size 4100
3e |Size Adj % 100
4a [Size Percentage | 6707.317073
5a |Size Percentage Lookup [ 67.07317073
~ Look Up Price and Units Based on Size %
6a |High Units _ 6800
7a [LowUnits 6600
8a [High Price 1.05
9a |Low Price . 10e
11a [High Price Minus Low Price | 0.01
10a |High Units Minus Low Units [ 200
12a |Price Divided By Units | -0.0000500000000000
13 [Size Percentage MinusLow Units | 107.3170732
14a [Size Adjustment | 1.05463
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You are here: Table Maintenance > Understanding the Outbuilding Size Curve

O VISION

GOVERNMENT SOLUTIONS

Understanding the OBXF Size Curve
Calculation

This document will explain the Table Maintenance, Building Tables, Size Curve Calculation for Outbuildings and Extra Features.

This document, in conjunction with the associated spreadsheet, demonstrates the size curve calculation. A screen shot of the
worksheet is also available at the end of this document.

1. To determine the size adjustment the user must first gather the pertinent variables.

a. Parcel > Outbuildings > Code

Primary Outbuilding Information
Code ALL: LEANTO M
Sub Type

b. Parcel > Outbuildings > Subtype (If Applicable)

Primary OQutbutlding Information
Code |ALL: LEANTO x
Sub Type

¢. Parcel > Outbuildings > Units

Units 2400
Measure 1 40
Measure 2 60

d. Table Maintenance > Building Tables > OBXF Codes — Find the indicated Outbuilding Code (1a) and
SubType (1b) from above, and determine the Size Adjustment Code

Table Maintenance B
Building Tables

Cost Use Codes
Cost Group Rates
Blelging Mogel Types

Styie Codes
Size Ad:ustment Tabie
Subareas
COBXF Codes
OBXF Grade/Condition
EYB Depreciation
Deptecistion Tables
Outtiulicing and Extra Festure Codes
Type | Both |
_ Fowed | M b it S St
Code | Descoption Sub Desc Unit Price pr:h: r:.‘ :::: ? L::pc ‘\n:‘ St:-
> AL Bank Barr C R - 000 000 U |5 - | 5000
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e. Table Maintenance > Building Tables > Style Codes — Find the indicated Outbuilding Code (3a) and
SubType (3b) from above, and determine the Standard Size

Outbuilding end Extre Feature Codes
Type | Both .
Code Descnption Subs Dexc Unit Price pl:"'gu‘“i :,.:
.
» ABL Bank Bam wn 000 000 UT ABYL -

2. With known variables, the first calculation determines the Size Percentage

a. (10,000 / Standard Size) * Units

Example:

(10,000 / 3080) * 2,400

Size Percentage = 7792.207792
3. For future calculations, divide the Size Percentage (SP) by 100

a. (Size Percentage / 100)

Example:

(7792.207792/ 100)

Size Percentage Lookup = 77.92207792

4. Table Maintenance > Building Tables > Size Adjustments - Find High Units

Vision 7 Application Explover _'_“_] Size Adjustments:
=i ARL
-
St Adistment Tadie ‘ b ABL ABL
a. 1Value Higher than 3a — (Size * 100)
70.00 1.0600

» |[__so00] roso
Example:

(80 * 100)

High Units = 8,000
5. Table Maintenance > Building Tables > Size Adjustments - Find Low Units
a. 1Value Lower than 3a — (Size * 100)

» [ oo

80.00 1.0400

Example:

(70 * 100)
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Low Units = 7,000
6. Table Maintenance > Building Tables > Size Adjustments - Find High Price

a. 6a corresponding factor — (Adjustment Factor)

70.00 1.0600
£0.00 RN Lw:»-a]
7. Table Maintenance > Building Tables > Size Adjustments - Find Low Price
a. 7a corresponding factor — (Adjustment Factor)
[ 4 ?0.00‘ =3 }6021!
80.00 1.0400
8. Calculate High Units minus Low Units

a. (4a—5a)

Example:

(8000 - 7000)

High Units Minus Low Units = 1000
9. Calculate High Price minus Low Price

a. (ba—7a)

Example:

(1.04 - 1.06)

High Price Minus Low Price = -0.02
10. Calculate Price divided by Units
a. (9a/8a)

Example:

{-0.02) / (1000)
Price Divided by Units = -0.0000200000000000
11. Calculate Size Percentage — Low Units

a. (2a—5a)

Example:

(7792.207792- 7000}

Size Percentage = 792.2077922
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12. Calculate Size Adjustment

a. [{(10a * 11a) + 7a]

Example:

[{-0.0000200000000000 * 792.2077922) + 1.06}

Size Adjustment = 1.04416

Example Worksheet

. Gaculate OBXF Se Adjustment |

Step Variables I
la |OBXFCode S AB1

1b | OBXF Subtype - If Applicable

1c |Effective Asea 2400
1d Sire AdjustmentCode AB1
le |Standard Size 3080

|

- = |

2a [Size Percentage ] 7792.207792|

- 1

3a |Size Percentage Lookup | 77.92207792|

Look Up Price and Units Basedon Size %

42 |High Units 8000
5a |Low Units 7000
e — —
. . ]
6a |High Price 1.04
7a_ |low Price ... Loe
Calculate Size Adjustment
8a_[High Units Minus Low Units | 1000
9a_|[High Price Minus Low Price | 002
10a | Price Divided by Units [ -0.0000200000000000|
|
11a |Sze Percentage Minus Low Units | 792.2077922
12a [sizeAdjustment [ 104416

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Parcel Admin Tools > How to Create a Vacant Parcel

OVISION

GOVERNMENT SOLUTIONS

How to Create a Vacant Parcel

The purpose of this document is to walk a user through the process for creating a Vacant Parcel. An example of
when this may be use is for the completion of subdivisions.

1. Click on Utilities, Parcel Administration, Create Vacant Parcels.

File Cards i Utilities ] Help
}a Job Queue | EE o =
Vision 8 Apol |_ Recalc Parceis b
Parcel _ ‘Parcet Administration » Create Vacant Parcels
Legal Inforn Utilities » Copy Pa
Sales Analysis Utilities ’ Move Buil
Camp Snapshot Utilites » Lind Real Estate to Personal Property
x ]
Income Utilities »
Mass Update »
Change Password

2. Select a parent parcel — the parcel to be used to create the new parcel(s).

A. If the parent parcel is currently selected (displayed on the screen), click on the Use
Current Parcel as Parent check box.

‘ | Search | Step 1: Search For A Parent Parcel.

| Use Current Parcet As Parent
| P cel Qetr"'s

B. If the parent parcel is not currently selected (displayed on the screen), click on
Search.
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Step 1z Search For A Parent Parcel.

Use Curr Bs Parent
Pare~ Parcel Det=''s

3. Parcel Data from the parent parcel will then populate on the Parent Parcel Details screen.

[ Sesech | Step k Search For Ji Parent Parcal.

%) Use Currant Pasced 2a Parent

Parent Parcel Dutmls
WsLy 0

Froperty Location Al
[
Farcet 1D
Arzount Number | 000050
Lo Acren | 5
10| 01
ARID | oo

4. Enter the amount in the Land Units to Allocate and click Next.

bowet | Stap 1: Saarch For & Parunt Parcal.

m Lag Clrwet Pocel 31 Parmat
Oyt farmd Cevss

WRUD 0

Frpgarty Locston )1!\] M’j {1’1!94

Carret O
Peat ID

Aiomant Nomber |

!

| Larv Aoses 5
[ D oo
[ D oo

vt ety g SR

Step 7: Specity T Number OF Units T Allocate,

| nie R A 5 @g

Q&
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5. From the Specify the Starting Criteria screen:

1. Enter the Number of Parcels to Create.

2. Click on the Vacant Use Code drop down arrow to choose a vacant Land Use Code.

3. Enter Default Lot Size amount.

4. Click on the Default Parcel Status drop down arrow to choose a Parcel Status.

5. Click on the Default Work in Progress On check box.

Step [: Specify The Starting Criteria.
Startng {rteria
MRY 10 %
Property Location 45 N MAIN 5T

Accaum Number 106201014
Pa 000018
Anternateld 000100203015
Rus NBb | 0001 Delacit |+
Conmt Nbhd | D0O1: Defautt | *
Cando NEhd | 0091: Default | ~

<Dz
Vacant Use Code | 300v. SFO - Ur <t23 X
Defaclt Lot Sice <(3X

CUTAC) PP
3 ©>;.5,¢mmtn’wm'°"

® Of Pareels To Create

15

6. Click on the individual check boxes of each of the fields to be applied to the newly created
parcel(s) on the Specify the Field Increment Values screen and click Next.

7. Click on Generate Parcel List.

Step & Specify The Field Increment Values.
Increment Fields.
MW
Fimep  {lBlock Fllot  [JUst  Incremently
Street Number Increment By
Apartment Number Increment By
! Account Number Increment By 1
4| Pin Increment By 1
4 Alternate ld Increment By |
Bace Cancet || W
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Step 5: Generate The Parcel List

‘ l Generate Parcel List i(: =i (

Potential Parcels
‘ Status Map Block Lot

8. Once the new parcel(s) are generated, the parcel data fields can be edited on the Generate the
Parcel List grid screen.

9. Once the edits are complete, click Next.

Potential Parcals

| Status Map Block Lot Unit
Active = 100 Pt 30 15
Active ® 100 20 30 15
Active b 100 20 30 i5

| _ Previous i  Cancel Net <_ 4

10. Select the data to be copied from the parent parcel to the vacant parcel(s) using the check
box(es) from the Specify the Data That Will be Copied screen.

1. Click on the Copy All check box

OR
1. Click on the individual data table check box.
Then:
2. Select a Sales and Assessment History check option.
3. Click on Track Changes check box to generate an Assessment Change Maintenance table
entry.
11. Click Next.
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Step 6; Specify The Data That Will Be Copled.

wml (P
b B ADORESS | Seles And Assessment History
r P EXEMPTS © Do dak Copy Sales Infarmation v
» B OTHERASS & Copy Curent Sates Information C@]
» B NOTCEHIST C Copy AR
» @ VISITHST
» @ ILOGPERM Capy Assessmant Mistory
» 8 REIMAGES
» B NOTES
! T COCUMENTS
| » B OvRAD)
1 Crange Tracking
. 1] Track Changes T me S S -
: amhmcdiipgsgummm N '_-CiS)z
| Acceptance Code | 2: Land Assessmem = |
Facel Yewr 2014
T | =~ D () &

12. Check the Review the Parcel List and Data That Will Be Copied screen to ensure the parcels
selected will be created as desired.
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‘tep 7: Review The Parcel List And Data That Will Be Copled

M »h—a:—’uA_Jei“ A BT ke e i A Nﬂtm_“.»__.»“;_ km =3 —,_,_‘-:dui FONDI N I RLIPL S Iu‘wm !4» E T .1“‘ Cn -._a_‘_‘_is:’

| At v W0 x £ 15 100203016 13 .
| Actwe » 100 0 )] 15 100203017 13 %
| Actwe « 100 b 20 15 100203018 15 %1

» ADORESS Sales And Assescment History

| » EXEMPTS € Do Mot Copy Sades Information

> OTHERASS & Copy Current Stles Information

» NOTICEWIST C Copy A8

> VISITHST

» BLDGPERM 1] Copy Assessment History

# REIMAGES
| ® NOTES
| » QVRAD)
| . Change Tracking
| 1] Tk Crunges

Reason Far Change Code  01; Reavsessmmnt
|
Acceptance Code ;. | nd Assrssment
Fiscal Yewr 014 |
13. Click Execute.
14. Check the Status of the Monitor the Status of the Vacant Parcels screen.
Step 8 Monitor The Status Of The New Vacant Parcals. 1
Vet fared Crastion Siens
N — Proputy Location Adgognt # PO Sratus
e M M I 12 M 5T 100013 47 Suacess
Crantion Eronss: ;-
<2

15. Click Save.
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Previous Concel || Save < . ¢

Note: If the Status shows an error, and are messages in the Creation Errors section, please
contact Customer Support at 800-628-1013 x6000.

Creation Errors - E
' am—

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Parcel Admin Tools > How to Copy a Parcel

OVISION

GOVERNMENT SOLUTIONS

How to Copy a Parcel

The purpose of this document is to walk a user through the process for copying a parcel information from a source parcel to a
target parcel. Make sure there is a valid database backup file created prior to using this tool, as once the process is executed,
changes cannot be reversed. Having a valid backup file ensures that any changes can be reverted back to an older day’s status,
if necessary. Contact Customer Support if you need assistance with ensuring you have a valid database backup.

1. Click on Utilities, Parcel Administration, Copy Parcels.

File Cards | Utilities I Help
}a . lob Queue ' EE prre
Vision 8 A L’ii Recalc Parcels »
Parced | Parcel Administration » | Create Vacant Parceis
Legal Infor Utilities v Copy Parcels
| Sales Analysis Utilties vl Mow gs
| Comp Snapshot Utilities » Link Re Personal Property
| |- —
Income Utilities »
Mass Update »
| Change Password
|

2. Select a parent parcel - the parcel to be used to create the new parcel(s).

If the parent parcel is currently selected (displayed on the screen), click on the Copy
Current Parcel Data check box.

Sewch | Step L: Seerch for the parcal to be copied

¥ Lopy current parcet date

If the parent parcel is not currently selected (displayed on the screen), click on Search.
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3. Parcel Data from the parent parcel will then populate on the Parent Parcel Details screen.

Sgrort Raresd Dutule

Prperty Lotaton (143
Comnt Owaer (it sesktisy,
ParcWl 10 [y
Aot Musnber c0x0. 101 |
Unddon | 144, H
P
&f Porot

4, Click on the Copy Current Parcel Data check box.

5. Click Next.
Search Seop 31 Search Par The Parcel To B Copled

K| Copy Camant Purcé Uome
Current Pareel Desuils: —

L LT 1%

Pragarty Localion | 17 B MAIN $T W
Curment Owmer :
Paieed D : >

Actount Number ' 100203012
Land Aere
o
ArID

Cancel Nt X

6. Click on Search Button to find the parcel to which this data will be copied.

| SeschButton  Step 3: Search For Target Parcels
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Note: Only vacant parcels can be selected

| SeashBution | Step 3 Search For Target Parcels

i {3 Select AN Q

{bTargetParcel B location ~ [MBW |Owner Full Name Co-Owner Full Name State

32 32N MAINSTSTWUNIT 1007 /207 /30/ /32/ MICHAEL MILLER MARYMILER 410V

33 IINMAINSTW 100/ /207 /30/ 133/ MICHAEL MILLER MARYMILER 410V

i 34 34N MAINSTW 1007 /207 /30/ /347 MICHAEL MILLER MARY MILLER 420v
- 36 36 N MAIN ST W 100/ 120/ /30/ /36/ MICHAEL MILLER MARYMILER 500V
| 48 12 MAIN ST 104/ /247 /347 116/ MICHAELMILLER MARYMILLER 100V

7. Select the parcels to be included in the copy process:
= Click on the Select All check box OR

# (Click on the individual parcel check to box select the parcel.

Blseecm < X

*krarw Parcel Pid|location  MBUW S—— | Owner Full Name | Co-Owner Full Name State
32 32 N MAIN STSTW UNIT 100/ /207 /307 /327 MICHAEL MILLER MARY MILLER 410v
33 3INMAINSTW 100/ /207 £30/ £33/ MICHAEL MILLER MARY MILLER 410v
34 34 N MAIN STW 1007 720/ /307 /34/ MICHAEL MILLER MARY MILLER 4207
36 36 N MAIN STW 100/ /20/ /307 /367 MICHAEL MILLER MARY MILLER 500V
48 12 MAIN ST 104/ 7247 /344 716/ MICHAEL MILLER MARY MILLER - 100V
8. Click Next

[ previous |[ Comcst  |[ mnex X

9. Select the data to be copied from the parent parcel to the vacant parcel(s) using the check box(es) from
the Specify the Data That Will Be Copied screen.

- Click the Copy All check box OR

- Click the individual data table check boxes.
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10. Click Next.

&

CRUEL R TEL

]

ABATEMENT
ADORESS

AMDATE
ALT_APP_HIST
Appicantinformation
ASSHIST

BLDG

| BLDGPERM
| CO_DETAIL

CONSTR

CONSTRCDM
CONSTRCDU
CONSTRCOM

| CONSTROEP

CONSTRRES

| CSSTORE

CrrdctualView

| DELMAST

EXEMPTS
HRES

Ve

| Previous

] L

" 7 r
Lancei J | Nent

11. Check the Review the Parent, Targets, and Data to Be Copied screen, to ensure the information is

correct.

v ¢ Bomem The Parem, Torgom il et To e Copmasd
(e S

* abatinay) Lt Py vt Dt
. arOE -
PRI LT R TTRT

VR A WA

L e

12. Click Execute.
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13. Check the status on the Monitor the Status of the New Vacant Parcels screen

T3 B N ST W ke ]

30 W ki SFW ‘
e R AT AW
13 A 61 ) |

14. A successful process will result in the status identified as Copied.

15. Click Close

Note: If at any time, the Status shows an error, please call Customer Support at 800-
628-1013 X6000.
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You are here: Parcel Admin Tools > How to Move a Building

OVISION

GOVERNMENT SOLUTIONS

Utilities — How to Move a Building

The purpose of this document is to walk a user through the process for moving a building from one parcel to
another.

1. Click on Utilities, Parcel Administration, Move Building.

File Cards |Utiliﬁu_| Help
.}3 Job Queue i EE E_%
Vision § Appld Recalc Parcels 3 NS, S T N b o, _mily
Pascel _ Parcel Administration » : Create Vacant Parcels
Legal Inforr Uilities > I Copy Parcels
Sales Analysis Ltilities > Move Buildings
Comp Snapshot Utilities 3 Link Re. to fersonal Property
Income Utilities -
Mass Update »
Change Password |
—— .

2. Select the parcel that the building is being removed from.

If the parent parcel is currently selected (displayed on the screen), click on the Copy
Current Parcel Data check box. The parcel data will appear in the Parent Parcel Details
section.
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Step 1: Select Parent Parcel

Current Ag Parent

t el Details
MBLU 100 20 10 2

Property Location 3  MAIN STW
Current Owner | J41C HAEL MILLER

Parcel 1D

If the parent parcel is not currently selected (displayed on the screen), click Search. The
Search box will appear. Once the parcel is searched, the check box will activate and the
parcel details will automatically populate

e )

|Shpl:50hctl’mthrcd DI

] Current As Parent
Parent Parcel Details

MBLU

3. Parcel data from the parent parcel will then populate on the Parent Parcel Details screen.

4. Click Next.

: Stop L Select Parwet Parest

| R Comens 2u Ryroms

| taree fomei Cames
-

Sy Louwen | 5 b s 4T W
Ppcel D
Aezmunt Numsss |11
e Apws
B o

[T <A
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[

5. Click on Search to invoke the Search for Targeted Parcel.

6. Highlight the parcel with the building to be moved and click Next

| Search Step2: Select Target Parcel
Internal ID Location MELU Owner Full Name | Co-Owner Full Name | Pnmary Use
s oot i 1004423044307 337  MICHASL MRALR  MARY MRLER -« - &0C
Maove Building
MBLY )
Property Location MAIN
Cureent Owner | ssicHac Ml ER
Parcel D 42 o 3

Account Number | 10000 % Q

i Previous || Cancel {| Next ||

7. At the top of the next page, select which building is the one to be copied by placing a

check in the Is Target box.
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Step #: Select Buildings To Move
{El Setect Al
Is Target

4 v ll 0.00 0.00 0.00

8. The Building Details will show at the bottom of the page.

9. Choose the Vacant Use Code

| 100V. $FD - Ueben Vecamt
Notesd | J0XF 5D - Sutwirtun - Farm
| 26QV- SKD - Sastwarinar: - Ve
Notes® | 500r agricusiuel 10 - 99 A< « Farm
| S00v: Agrcuttaral 20 - 99 AC
oS3l | oo Agrcummarsl cver I8 - Faren
Kotead] | 500V Agricutumst over M
| T00V: Exempt - Vac

meml v]

Prewous | Cancei

10. Click Next.
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11. Verify the data on the Review Selection screen.

12. If you are satisfied with the information, click Execute.

Step & Review Selections [
Parert Porce Datady
MBLY
Fropety Lot aton
Curmnnt Ommar | (1 iie
Bpiyel 10
Accoumt Nurmibes |
Mipwe Budding
MBLU
Property Locades | 10 a saain 1 W
Corramt Onree 11,
ol

A comart Nt

Boioag Camain
A g v
1 Q00 GO0 GO0
A
Prevons Camcal Enecuto

13. Check the Move Status on the Review the Move Status screen.

14. If the building is confirmed to be moved, exit the application by clicking Close.
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| Step % Review the move status

Mave Status
Move Status

1 0.00 0.00 0.00 Copied

Note: If at any time the Move Status does not show that the building was copied, please
contact Customer Support at 800-628-1013 x6000.

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Report Wizard > Report Wizard Overview

OVISION

GOVERNMENT SOLUTIONS

Report Wizard Overview

The purpose of this document is to give the user an overview of the Report Wizard. The Report Wizard allows the user to
create their own “customized” reports by selecting various TABLES, FIELDS, and SELECTION CRITERIA to adjust the report to

suit the requirements.

1. Navigate to the left-hand menu tree, and click on Reports

() parce

Owner Maintenance
@Wﬁwwv erintiaey
E Table Maintenance

Comps & Apportionment
Cost Modeling

[T} Track Changes

T Aol

L . T =

2. The Report Wizard screen will appear.

o k)
et o, st Cotatna Comb, Mgt
S e (e Sapt Ypm Ve =] e

o Ay Ty
Mssi e o Uy Ve
Awtie rares

® Lage donw Oun: A 1 oy o 5 Amm B

[ . Tt s Y

; e - Tewgmn: _dwm , oA Sogut S
.S gy N b — e

i dems fone bl . Mpet | e

® oom Aen Srre Corrs wot fon Do Sefwmni gt Caterve et St

Select Table and Columns Section

1. Select a Sample Row of Data: Once a report has been created, this section allows user to review a
particular line of information

2. Column View Options:
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a. Show Parcel Data - Shows all parcel-related tables

b. Show All Table Data - Shows ALL available data tables when a table is selected

¢. Show Friendly Names - Shows the more user-friendly field names within a selected column

d. Show Active Parcel — Shows only parcels with an Active parcel status

3. Mail Merge:

a. Mail Merge check box - Indicates a mail merge is being created with the Report Wizard

b. Save to Associated Doc - Indicates the merged document will be attached to each parcel
affected as an Associated Document.

c. Template - Shows the path to the template being used for the merge resides.

d. Save - Indicates where the final, merged document file will be saved, for review, printing,
etc

4. Custom Report: A list of any/all reports created and saved by an individual user.

5. The buttons to the right of the Custom Report list are used to make changes to the reports
contained within that list.

a. Edit —Select a report from the list and click here to activate/make changes.

b. Delete — Removes the report from the Custom Report list.

c. Import PIDs — Select only parcel data that corresponds text file with a list of PIDs (i.e.
pidlist.txt)

d. Export- Once a report template is created (a .RDL file}, it can be saved to a different
location (i.e. a new report shared amongst multiple users in the office)

e. Import — Bring into Vision a report template (.RDL) that was previously saved to a different
location.
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6. Show Preview Report Columns and Data — As a report is constructed, this button allows the user to
see in the Preview Report Output screen, each field as it is added.

7. Show Selected Report Columns and Data — Once the report is created and tested, or when a
Custom Report is opened, this button will show exactly what tables/fields are in use.

® Show Preview Report Colusm and Data ({0 Show Selected Raport Columng and Dats

8. Preview Report Output — Allows the user to view the data as it is being added to the report. While
the end result may have more or less information, this section gives a rough idea as to what the final
product will show.

9. Group By Levels — Allow the user to organize and sub-set data in the report.

10. Title — Prior to being run, any report created and subsequently generated by the Wizard must have a
title.

Creating a Custom Report in Report Wizard

From the Select Tables and Columns section, identify the tables and related columns necessary to create the custom
report.

1. On the main Report Wizard page, a list of TABLES will be visible.
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2. Click on the plus sign = icon that appears next to the table you would like to include in your report
to view fields available within that table.

Preview Report Columns and Data:
|

Table Name
NOTES
NQTICEHIST

OBXF

OTHERASS
OVRAD)

PARCEL
REAL_OWNERSHIP
SALERIST
VISITHST

B 8 @ &8 & @

®

&
v

@

3. Then click on the boxes to select the individual fields to be displayed on your report.
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Preview Report Columns and Data:

a

'Table Name

REALMAST

Include ' Column Name iSarr_\pIe .
SEN T

™% REM_ALT_PRCLID
REM_ASSOC_PARCEL_ID
REM_ASSOC_PCT
REM_BLDG_NAME
REM_CROSS_STREET 1
REM_CROSS_STREET_2
REM_FIELD_REVIEW 0

4. An option to select field alignment is also available by clicking the Alignment dropdown and
selecting Left, Center or Right.

Mmmnt 5
Tatie MNarre
Inchude Column Name
REM_SABLU UNGT
REM_MBLU_UNIT CUT
REM_MboC
sV REM_OWN_NAME
REM_PARCEL STATUS
7 REM_FIC
REM_ "N
REM_PRCL B
REM_PRCL LOCN

Sample Formula Filter Agnimesa Format \
415
MURFHY PRSHA M
A .
| Center
1 " | Right
1
7S SMITH AVE

5. For any numeric fields, the user may choose a number format by clicking the Format dropdown.

In the example below, we selected a currency format for the Total Appraised Value field.
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Preview Report Codemns arut Oater LB
Tutrw ‘upsw
Incuge Conmn Nawe Semgpic Fommuls il | Nigremert ' Format
PRE TTL APRORTN 6 . = 5
PRC_TTL APPRANY 279000 8 = =
ot PROTTRARI oG 4 o e i = |te2e0 -
PRC_TTL_ASSESS WO [ 280 0] i
PRC_TH_COMP_ASSORTN b} - 000
pag T COAT %0 L |G
[
PRC TTLINCOMSE o - - o . 11,
PRC_ TTLAND AREA BCRLS 0 ASHIO0OC . » |y
Milddlyyy
PRC_TTL FEIGRESSION Qo . " | MMddApy B enen
i 3 oo =
Proview Regert Outpnst Gophloas | "] 00000 |
REM PID ~ | AEMACCT_NUM | REM_PROLIDCH  PRC_TTLASSESS gmm
3 0314004 33 S00TH AVE $243 Yoo 14
> . N v . 000N
i 23500600 95 ShAITH AVE §ist 00 a000%
’ 15040 -0 B3 STh AVE §246. W) D000,
4 61600 5 FANNING LANE §125700
] 100611 - B7 ST AE Fa55 g
B e SOTIER o R EMITHANE SIS0 ~ .
El 349012 19 38iTH AVE £221.900
H 130114 00 7 THAVE  §208800
i 1831329 2% 6 $AMNING LANE 347 400
1 13-31%06-27 1 SHANT BVE $295 0600
6. As you select fields, a preview of your report will display on the bottom half of the screen under
Preview Report Output.
Aavion Supart Outpt mgm:- i - — il - .
I PD A SO MU B0ad FRCLLOC N M TN T PG LOEN STME! M Gt iy
2 e o b B WSk Aot AR_AB e 1D h A
1 R0 2 ) . FWTTH AL ARLIRAY FRANIIS SATHR £ 29
P E N2 e e ST el AT IERNSTIN
5 k] SMTT 34T QES IETRIARLE SAMLY TRST
N [ P aut £relE e ¢
- 5 FRNMOAE LANE ATAMLEY SENELTEE
(] ' AT R L CHITAL E WhElAw 4 (T
3 3 TH LT LB GRS &
% 3 AW sl BIALE A
o [ cariaTa |ibt TINARDY ARALC A T UK
- sy
7. Once you have all of your fields selected, you may change the order of the columns by single left-
clicking on the column header and dragging the column to the desired area.
I. Step 1: Single left-click on the column to be moved.
Preview Report Output GoupBylevew | % Titke:
REMAD - REMACCTNUM | REM_PRCLLOCN NUM CHAR  REM.PRCLLOCN STREET | REMCONBUNAME 1y
) 02-1760-04 33 SMITH AVE BORDEN ASHLEY £
8 23101600 9L SMITH AVE WILSON DORES A
7 15044900 # SMITH AVE ORTOLEVA WILLIAM £ ET X
3 19-2616- H FANNING LANE TANLEY PENELOPE £
5 10-0611-40 g7 SMETH AVE JQYCE DENNIS &
4 10-0077-52 85 SMETH AVE JAQRIES REVOXCABLE FAMALY TRUST
3 08-1896-12 9 SMITH AVE HURST JENNEFER
2 13-0114-00 77 SMITFH AVE MACKAY FRANCIS PATRICK £T UX
16 19-1329-1% 5 FANMING LANE SIMBRON JERALD A BT UX
1 13-3506-37 75 SMITH AVE MURPHY PASHA M

Il. Step 2: Drag the column to the desired position
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- Title: !

i
REM OWN_NAME y
)
9  02-1760-04 ! SMITH AVE BOADEN ASHLEY £ :
P BNER0 9 e e SNTHAVE - o . - WRSONDORSA }
7 15-0449-00 » SMITH AVE ORTOLEVA WALLIAM E. ET UX {
& 19-2616-00 H FANNING LANE STANLEY PENELOPE
5 10-0811-40 87 SMITH AVE JOYCE DENNIS € \
4 10-0077-52 s SMITH AVE JAQUES REVOCABLE FAMILY TRUST [
3 08-1896-12 » SMITH AVE HURST JENNIFER )
2 130214-00 7 SMITH AVE MACKAY FRANCIS PATRICK ET UX |
10 19-1329-25 6 FANNING LANE SIMERCN SERALD 4 ET UX )
1 13-3506-37 7 SMITH AVE MURPHY PASHA M ‘
lll. Step 3: Release the mouse button. The column will now appear in a different area of the
screen.
Preveew Report Output Group By Leveiv | -J Tthe:
REMLPID = REMLACCTNUM | REM_OWN_NAME @ REM_PRCLLOCN NUM.CHAR | REM_PRCL LOCN STREET
39 02-1160-04 BORDEN ASHLEY € 9 SMITH AVE !
] 13-1016-00 WILSON DORIS A 9 SMITH AVE 1
’ 15-0446.00 ORTOLEVA WILLIAM E. ET UX 8 SMITH AVE |
6 19-2616-00 STANLEY PENELOPE J 3 FANNING LANE )
H 10-0611-40 JOVCE DENNIS € v SMITH AVE
P4 O0WRS) AQUESREVOCABLERAMIY FRUST - - - - @5 - SMITHAVE
3 04-1896-12 HURST JENNIFER ] SMITH AVE :
2 13-0114-00  MACKAV FRANCIS PATRICK ET UX n SMITH AVE '
19 19132925 SIMBRON JERALD A ET UX ) FANNING LANE 1
H 13-3306-37 MURPHY PASHA M 7 SMITH AVE _
'
8. Once all of your fields are added and in the desired order on your report, add a Title to your
report and click Next to view your completed report.
———— T T APRASED WU < "11)
Rl RO M ACCY s M PO OO PR TR Asael
] 2100 93 5METH AVE $245 TR0
L] 25 1016 91 8T Kol L
F pRECTES A9 ShFTE AVE 248 30
o2 Vsl L M YR
L 103340 A7 It $Lv5 0
b CMRAT AR e A6Pam
& o112 PR IAGTH A1 jb2eq ]
X 13011400 77 ShlTH AvE 20k 500
L] Wiken (LD P TR
1 13336583 7Y SANTH ave waam :
) L.l'-‘..' lg‘ S |

9. Your Report will appear on the screen.
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Create a custom report using a specific PID list is also possible, provided the list of PIDs is

Repor Wizard
o -
i 4 of2? » Pi100% =) Fint
ASSESSED VALUES
EM_ PID © IEM_ACCT HUM REM_ PRCI
2z 00000401 117 SEA AVENUE
3 00000501 113 SEA AVENUE
4 00000601 109 SEA AVENUE
5 00000701 105 SEA AVENUE
6 00000801 9% SEA AVEMUE
7 00000901 93 SEA AVENUE
] 00001001 89 SEA AVENUE
9 Q0001101 143 SEA AVENUE
Ho 00001204 137 SEA AVENUE
i1 00001301 131 SEA AVEMUE
12 00001401 125 SEA AVENUE
13 0000150t 122 SEA AVENUE
14 00001601 71 MEARS AVENLUE
is 00001701 79 MEARS AVENUE
16 00001801 8% MEARS AVENUE
17 00001901 118 SEA AVENUE
1 00002001 112 SEA AVENUE
1] 002191 108 SEA &% Yk

| Next

1OEN

- v & B

PRC_THL_ASSESS

822
€311,400
$0

30

$2

$0
$3M,300
$261,100
-$t
$3L7,500
$323,100
$261.800
$104,200
$176,000
$178,000
§245,800
$262,800
$257 ann

available as a .TXT file. This file would be imported first, then the report would be created

as desired. Once complete, only the PID numbers originally imported would show on the

resulting report.

10. Create a TXT file of the PIDs to be imported to Vision

11.

Bapir Benery

Setact TRONG Wad ok

File Bt Format View Aeip

Go to the Report Wizard an click on Import PIDs

SR 5 SAUTEE wow O e Cutmme, Yypw Ot Reprt Typw ad Mame
Il ® b Pt Dme Wi Myeyr Sovy 0 Avucwrpmpy (B0
e Vs Wl T » T T 5
B Framcly o L
s | o

o, Vs Actun Percw

@ Snsw Pievew Sepcrt © uni snd Tata
7 pivee Pwe
= Wi

| £ s

v Setet e BEpart L sheres wac Dils

| oy
AT

12. Navigate to the PID list file created, select the file and click Open

274

hrpom ADs
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% ot gt I s Dewinp B #

Clgaraze v Hea Niile - -] l

PR

A 7 Dacumenistion - Shoead
ASSESIEDY WALLES i b
EGORT R
& cicope Cvame
p  Hebar {omputer Seracen Teen *aotes
WSORT o 1 1
el et LRGN Bt A Dt Drsq e | =

ﬂ -k.\
&
& |
| .@k

Fobg NAINE icast et

Open
e~ e e e N~ W R T~ " m—— | ——

13. Create the report as desired. Review the Preview Report Output section of the screen to ensure the
fields selected are appropriate and click Next.

; Prgvees Peport Outpd Grup By vt . Tl irpnnt w3 Lemansimban,
| B LS PN P ST T AL R, MO A san DTN AL teas ',r.»_x-
ARCHAE WD 1 WL Fe—— A 000
MACHE ML 2 Wi Adrptims My A
L3 ) WAL MALLES D e e Arpam— A -
[ AL WAL, e Al A AV 00
5 Aty L Mx
¢ Aaryns ar R |
by Ay . e 8 Aty an A “ " |
§ ABCHALL AMLLER B M B AryTomes WA
@ AL, AR e eyt M o |
W WAL RRELES O s ok Arytane (TS WD O Q |
L . Nea
14. The report will display ONLY the specific PIDs from the TXT file:
Report Wizard

e

fed < |1 of 1 & ki o« 2 &dud- 100% - D Emd Mest
_| Import PIDs Demonstration

REA §1 O MmN A0 ML DR

1 MICHAEL MILLER 1 Main St Anytown MA 00000-0000
12 ER 12 Main St Anytown MA 00000-0000
15 MICHAEL MLLER 15 Mam St Anytown MA 00000-0000
2 MICHAEL MILLER 26 Main 5t Anylown 73 00000 0600
1 MICHAEL MILLER 33 Mam St Anylown Ma 00000-0000
M MICHAEL MILLER 34 Main St Anytown MA 400000600

Count: 6

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
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